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Maintenance and Service Guide

SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.



© Copyright 2010 Hewlett-Packard
Development Company, L.P.

AMD, ATI and ATI Mobility Radeon are
trademarks of Advanced Micro Devices,
Inc. Intel, Arrandale, and Core are
trademarks of Intel corporation in the U.S.
and other countries. Microsoft and Windows
are U.S. registered trademarks of Microsoft
Corporation. SD Logo is a trademark of its
proprietor.

The information contained herein is subject
to change without notice. The only
warranties for HP products and services are
set forth in the express warranty statements
accompanying such products and services.
Nothing herein should be construed as
constituting an additional warranty. HP shall
not be liable for technical or editorial errors
or omissions contained herein.

First Edition: April 2010

Document Part Number: 613839-001



MSG revision history

ENWW

Revision

Publication date

Description

A

October 2010

Added newly supported hard drives to spare parts listings in the
following locations: Computer major components on page 20, Mass
storage devices on page 30, Sequential part number listing

on page 33, Hard drive on page 47.

Added newly supported memory modules to spare parts listings in the

following locations: Computer major components on page 20,
Sequential part number listing on page 33, Memory module

on page 55.

Added newly supported processors to spare parts listings in the
following locations: Computer major components on page 20,
Sequential part number listing on page 33, Processor on page 85.

Added newly supported system boards to spare parts listings in the
following locations: Computer major components on page 20,
Sequential part number listing on page 33, System board

on page 76.

Added newly supported display assemblies to spare parts listings in
the following locations: Computer major components on page 20,
Sequential part number listing on page 33, Display assembly
components on page 27, Display assembly on page 70.

Added newly supported back covers to spare parts listings in the
following locations: Computer major components on page 20,
Sequential part number listing on page 33, Display assembly
components on page 27, Display assembly on page 70.

Added newly supported optical drives to spare parts listings in the
following locations: Computer major components on page 20, Mass
storage devices on page 30, Sequential part number listing

on page 33, Optical drive on page 50.

Added newly supported fan/heat sink assemblies to spare parts
listings in the following locations: Computer major components
on page 20, Sequential part number listing on page 33, Fan/heat
sink assembly on page 81.

December 2010

Added newly supported processors to spare parts listings in the
following locations: Computer major components on page 20,
Sequential part number listing on page 33, Processor on page 85.

Added newly supported system boards to spare parts listings in the
following locations: Computer major components on page 20,
Sequential part number listing on page 33, System board

on page 76.
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Safety warning notice

A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category Description HP G62 HP G62 Compagq Compagq
Presario Presario
CcQ62 CcQ62
Discrete UMA Discrete UMA
Product Name Compaq Presario CQ62 Notebook v v
PC
HP G62 Notebook PC J J
Processors AMD Phenom™ N930 Processor \ N S \
(2.0 GHz, 2 MB total L2 cache, 1333
MHz)—Quad core 35 W
AMD Turion Il P560 Processor (2.5 R S \ \
GHz, 2 MB L2 cache 1066MHz)—
Dual core 35 W
AMD Athlon Il N370 Processor (2.5 \ \ \ \
GHz, 1 MB L2 cache 1066MHz)-
Dual core 35 W
AMD Turion Il N570 Processor (2.7 \ \ \ \
GHz, 2 MB L2 cache 1066MHz)-
Dual core 35 W
AMD Phenom |l N970 Processor S S S S
(2.2 GHZ 2 MB L2 cache
1333MHz)-Quad core
AMD Phenom Il P960 Processor N \ S S
(1.8 GHZ 2 MB L2 cace 1066MHz)-
Quad core 25 W
AMD Phenom Il N870 Processor J J J J
(2.3 GHZ 1.5 MB L2 cache
1333MHz)—Triple core
AMD Phenom Il P860 Processor \ S S S
(2.0 GHZ 1.5 MB L2 cache
1066MHz)-Triple core 25 W (for
model 1.2 only)
AMD Phenom Il N660 Processor 3.0 J J J J
GHz 2 MB
AMD Phenom Il P950 Processor S S S S

(2.6 GHZ 2 MB L2 cache
1333MHz)-Quad core 25 W




Category Description HP G62 HP G62 Compaq Compaq
Presario Presario
CQ62 CQ62

Discrete UMA Discrete UMA

AMD Athlon Il P360 Discrete x/ y y v
Processor 2.3 GHZ 35 W (for model
1.2 only)

AMD Champlain V160 Processor N N N N
(2.4 GHZ 512 MB L2 cache
1066MHz)-Single core 25 W

Chipset ATI™ RS880M \/

Southbridge - SB820 v v \/ y

AMD™ RS880MD v N v

Graphics ATI Mobility Radeon™ HD5430 with v
512 MB dedicated video memory

ATI Mobility Radeon HD Graphics v v
(UMA, integrated) with shared video
memory

ATI Mobility Radeon HD 545v with v
512 MB for vision label mapping

Switchable Discrete Graphics N N

e  ATi Robson XT (ATI Mobility
Radeon™ HD6370) with
512MB of dedicated memory
(64Mx16 DDR3 800 MHz x 4
PCs)

e  ATi Robson XT (ATI Mobility
Radeon™ HD6370) with 1GB
of dedicated memory
(128Mx16 DDR3 800 MHz x 4
PCs)

Support for BD or HD-DVD playback v v v
with HD decoder and DX10 support

Panel 39.6-cm (15.6-in) HD LED v v v \/
BrightView (1366 x 768)

16:9 wide aspect ratio N N N N

2
2
2
2

Memory 2 customer-accessible/upgradable
SODIMM slots

Supports dual-channel memory N N N N
DDR3, 1066 MHz

Supports up to 8 GB of system N N N N
memory

Supports the following ~ N N
configurations:

e 4096 MB (2048 MB x 2) N N N

2 Chapter 1 Product description ENWW
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Category

Description HP G62

HP G62

Compagq
Presario
CcQ62

Compagq
Presario
CcQ62

Discrete

UMA

Discrete

UMA

o 3072 MB (1024 MB x 1 + 2048 N
MB x 1)

\/

\/

e 2048 MB (2048 MB x 1)

e 2048 MB (1024 MB x 2)

e 1024 MB (1024 MB x 1)

Hard drives

2 | 2| 2| <2

Supports 9.5-mm, 6.35-cm (2.5-in)
SATA hard drive

2 | 2| 2| <2

< | 2| 2| <2

< | 2| 2| <2

Customer accessible \

Supports the following drives:

750 GB, 5400 rpm N

640 GB, 5400 rpm N

500 GB, 7200 rpm

320 GB, 7200 rpm v

250 GB, 7200 rpm

160 GB, 7200 rpm

Optical drives

12.7-mm (0.50-in) fixed SATA tray
load

B T B L I

B T B L I

B T B L I

DVD+RW and CD-RW SuperMulti \
Double-Layer Combo Drive with
LightScribe

Blu-ray ROM with LightScribe DVD
+R/RW SuperMulti Double-Layer
Drive

Webcam

VGA camera, fixed angle with v
activity light and single analog
microphone

Microphone

Integrated single analog microphone \
(for models with no webcam)

Audio

High-definition audio supports S
Microsoft® premium requirements

with Presario/HP Altec Lansing

speakers

Modem (select
models only)

56K V.92 data/fax MDC modem \
(computer models not equipped with

a modem have a cover over the

RJ-11 jack opening)

Supports all worldwide certification S
requirements

Ethernet

Integrated 10/100 network interface <
card (NIC)




Category Description HP G62 HP G62 Compaq Compaq
Presario Presario
cQ62 CQ62
Discrete UMA Discrete UMA
Realtek 8102E \/ \/ v v
Wireless Integrated wireless local area
network (WLAN) options by way
of wireless module:
2 wireless antennas built into N N N N
display assembly
Support for no-WLAN option N N N
Support for the following WLAN
formats:
Broadcom BCM4312 802.11b/g N N N v
Atheros AR9285 802.11 a/b/g/n 2x2 v v v \/
Atheros AR9285 802.11b/g/n 1x1 v v v
WiFi Adapter
Broadcom 4313 802.11b/g/n 1x1 v v v \/
Broadcom 4313 802.11b/g/n 1x1 v v v v
WiFi and 2070 Bluetooth 2.1+EDR
Combo adapter (BT3.0+HS ready)
Ralink RT3090BC4 802.11b/g/n 1x1 N N N N
WiFi and Bluetooth 2.1+EDR
Combo Adapter (BT3.0+HS ready)
Realtek RTL8191SE 802.11b/g/n v v v y
1x1 WiFi Adapter
External media Digital Media Slot supporting SD, v v v v
card (select models MMC, MS, MSPro, xD cards.
only ) Supports mini versions of SD, MMC,
MS Duo with adapter, not included
Ports Audio-in (stereo microphone) N v N v
Audio-out (stereo headphone) v v v 3
High-Definition Multimedia Interface v v v y
(HDMI) version 1.3 supporting
1080p with High-bandwidth Digital
Content Protection (HDCP) key
(select models only)
Hot plug/unplug with auto-detect N v v v
RJ-11 (modem, select models only) N v v v
RJ-45 (Ethernet) v v \/ \/
USB (Three USB ports; one is an v v v \/
eSATA/USB port)
VGA (Dsub 15-pin) supporting 1600 N N N N
x 1200 external resolution at 75 Hz
Multi-pin AC power N N N
4 Chapter 1 Product description ENWW
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Category Description HP G62 HP G62 Compagq Compagq
Presario Presario
CcQ62 CQ62
Discrete UMA Discrete UMA
Keyboard/pointing Full-size keyboard, 39.62-cm(15.6- v v R \
devices in) with numeric keypad
TouchPad with 2 buttons and 2-way \ S S \/
scroll (taps enabled as default)
Power 6-cell, 2.20-Ah, 47 Wh battery \ \ \
requirements
6-cell, 2.55-Ah, 55 Wh battery v v v v
65-W AC adapter with localized S S
cable plug support
90-W AC adapter with localized S v
cable plug support
Security Kensington Security Lock \ \ \ \
Operating system Preinstalled:
Windows 7® Professional (32 & 64 \ \ \ S
bit)
Windows 7 Home Premium (32 & 64 \/ S \/ \/
bit)
Windows 7 Home Basic (32 & 64 S \ \ \
bit)
Free DOS \ < \ \
Serviceability End-user replaceable parts:
AC adapter S S S S
Battery (system) \ \ \ \
Hard drive \/ S \/ \/
Memory module \/ \/ \/ \/
Optical drive N N S S
Mini-card devices \ S \ \
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2 External component identification

Identifying the hardware

Components included with the computer might vary by region and model. The illustrations in this
chapter identify the standard features on most computer models.

To see a list of hardware installed in the computer:

1. Select Start > My Computer.

2. Inthe left pane of the System Tasks window, select View system information.
3. Select Hardware tab > Device Manager.

Add hardware or modify computer configurations using Device Manager.

ENWW Identifying the hardware 7



Top components
TouchPad

B—

O e — ©

Component Description

(1) TouchPad light Off—Touchpad is on.

Amber—Touchpad is off.

(2) TouchPad zone Moves the pointer and selects or activates items on the
screen.
(3) Left TouchPad button Press the left side of the TouchPad button to execute

functions like the left button on an external mouse.

(4) Right TouchPad button Press the right side of the TouchPad button to execute
functions like the right button on an external mouse.

*This table describes factory settings.

To view or change the pointing device preferences:
1. Select Start > Devices and Printers.
2. Right-click the device representing the computer.

3. Select Mouse settings.

8 Chapter 2 External component identification ENWW



Lights

ENWW

Component

Description

M

TouchPad light

e  Off—TouchPad is enabled.

e  Amber—TouchPad is disabled.

@)

Caps lock light

On—Caps lock is on

3) Power light e  On—The computer is on.
° Flashing—The computer is in Sleep.
e  Off—The computer is off or in Hibernation.
(4) Wireless light e  White—An integrated wireless device, such as a

wireless local area network (WLAN) device and/or a
Bluetooth device, is on.

e  Amber—No wireless devices are detected.

Top components
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Button and speakers

©

Component Description
(1) Speakers grill Two integrated speakers produce sound.
(2) Power button e  When the computer is off, press the button to turn on

the computer.

e  When the computer is on, press the button to initiate
Sleep.

e  When the computer is in Sleep, press the button to exit
Sleep.

e  When the computer is in Hibernation, press the button
to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power Options.

*This table describes factory settings. For information about changing factory settings, see the user guides located in Help
and Support.

10 Chapter 2 External component identification ENWW



Keys

ENWW

Component

Description

M

esc key

Displays system information when pressed in combination
with the fn key.

)

Send e-mail key

Opens a new e-mail in your default e-mail client.

®)

Media application key

Launches CyberLink PowerDVD.

4)

Web browser key

Launches default web browser.

®)

Print key

Sends the currently-active document to the default printer.

(6)

Calculator key

Launches the calculator application.

7

fn key

Displays system information when pressed in conjunction
with the esc key.

8)

Windows logo key

Displays the Windows Start menu.

©)

Windows applications key

Displays a shortcut menu for items where the cursor is
positioned

(10)

Action keys

Executes frequently-used system actions.

Top components
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Display

Component Description

(1) Wireless antenna (2) Sends and receives signals from one or more wireless devices.
(2) Internal microphone Records sound.

(3) Integrated webcam (select models only) Records audio and video and captures still photographs.

(4) Webcam light (select models only) On—The webcam is in use.

12 Chapter 2 External component identification ENWW



Right-side components

ENWW

Component Description
(1) Optical drive Reads and writes to optical discs.
(2) USB port Connects an optional USB device.

@)

RJ-11 (modem) jack (select models only)

Connects a modem cable.

4)

AC adapter light

o  Flashing white—The computer is in Sleep.

e  On white—The computer is connected to external power.

e  Flashing amber—The computer is charged.

e  Off—The computer is not connected to external power.

®)

Power connector

Connects an AC adapter.

(6)

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent,
but it might not prevent the computer from being mishandled
or stolen.

Right-side components
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Left-side components

YTy’

Component

Description

(1) External monitor port

Connects an external VGA monitor or projector.

(2) Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3) HDMI port (select models only)

Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or audio
component.

NOTE: Depending on the computer model, the computer
might include an HDMI port or a USB port at this location.

(4) RJ-45 (network) jack

Connects a network cable.

(5) USB ports (2)

Connects an optional USB devices.

(6) Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(7) Audio-out (headphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio.

(8) Digital Media Slot (select models only)

Supports the following optional digital card formats:
e  Memory Stick (MS)

e  Memory Stick Pro (MSP)

e  MultiMediaCard (MMC)

e  Secure Digital (SD) Memory Card

e  xD-Picture Card (XD)

9) Drive light

On—The hard drive is in use.

14 Chapter 2 External component identification
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Bottom components

Component Description
1) Battery bay Holds the battery.
(2) Vents (4) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine

operation.
3) Battery release latch Releases the battery from the battery bay.
(4) Memory module compartment Contains two memory module slots and, on select

models, the wireless LAN (WLAN) device.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.

(5) Hard drive bay Holds the hard drive.

Wireless antennas

At least two antennas send and receive signals from one or more wireless devices. These antennas
are not visible from the outside of the computer.

ENWW Bottom components 15



EY NOTE: For optimal transmission, keep the areas immediately around the antennas free from
obstructions.

To review the wireless regulatory notices, see to the section of the Regulatory, Safety and
Environmental Notices that applies to your country or region. These notices are located in Help and
Support.
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Additional hardware components

ENWW

Component

Description

(1) Power cord*

Connects an AC adapter to an AC outlet.

(2) AC adapter

Converts AC power to DC power.

3) Battery*

Powers the computer when the computer is not plugged into
external power.

*Power cords vary in appearance by country or region.

Additional hardware components

17
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3

lllustrated parts catalog

Serial number location

When ordering parts or requesting information, provide the computer serial number and model
number located in the battery bay of the computer.

ENWW

x IIILINAN
o (LT ETUEERE T

I

Component

Description

(1)

Product name

The name affixed to the front of the computer.

@)

Serial number (s/n)

An alphanumeric identifier that is unique to each product.

@)

Part number/Product number (p/n)

This number provides specific information about the product’s
hardware components. The part number helps a service technician
to determine what components and parts are needed.

4)

Warranty period

The duration of the warranty period for the computer.

®)

Model description

An alphanumeric identifier used to locate documents, drivers, and
support for the computer.

Serial number location 19
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Item

Description

Spare part number

M

39.6-cm (15.6-in) High Definition (HD), light-emitting diode (LED) display assembly
for use in:

NOTE: For more display assembly internal component spare part information. See
Display assembly components on page 27.

e  HP G62 biscotti computer models 595185-001
e HP G62 biscotti computer models with webcam 595186-001
e  HP G62 silver computer models (for model 1.0 only) 605141-001
e  HP G62 silver computer models with webcam (for model 1.0 only) 605142-001
e HP G62 matte black computer models (for model 1.0 only) 608109-001
e HP G62 matte black computer models with webcam (for model 1.0 only) 608110-001
e  Presario CQ62 biscotti computer models 602170-001
e  Presario CQ62 biscotti computer models with webcam 602171-001
e  Presario CQ62 matte black computer models 595187-001
e  Presario CQ62 matte black computer models with webcam 595188-001
e  HP G62 charcoal computer models (for models 1.1 and 1.2 only) 615583-001
e  HP G62 charcoal computer models with webcam (for models 1.1 and 1.2 only) 615584-001
e  HP G62 imperial blue computer models (for models 1.1 and 1.2 only) 622562-001
e  HP G62 imperial blue computer models with webcam (for models 1.1 and 1.2 only) 622563-001
(2) Power button board 595204-001
3) Keyboard (includes keyboard cable) for use in:
e Canada 595199-121
e Japan (for models 1.1 and 1.2 only) 595199-291
e Korea 595199-AD1
e  North America 595199-001
e Taiwan 595199-AB1
e  Thailand 595199-281
(4) Speaker assembly (includes cable) 602744-001
(5) Top cover (includes TouchPad board) for use in:
e  Biscotti computer models 595206-001
e  Matte black computer models 595207-001
e  Silver computer models (for model 1.0 only) 605147-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 615590-001
e  |mperial blue computer models (for models 1.1 and 1.2 only) 622567-001
(6) Fan/heat sink assembly (includes replacement thermal material) for use with:
e UMA systems 606609-001
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Item Description Spare part number
e Discrete systems 606610-001
e  HD545V discrete systems (for model 1.1 only) 617029-001
(7) Touchpad button board 595203-001
(8) Modem module (select models only)
e  All countries and regions except for Australia and New Zealand (for model 1.0 only)  510100-001
e  Australia and New Zealand (for model 1.0 only) 510100-011
9) RTC battery (includes mounting adhesive) 602745-001
(10) System board (includes replacement thermal material) for use in:
e PCA UMA system board 592808-001
e PCA UMA system board with modem and card reader 592809-001
e HD5430 PCA Discrete system board (for model 1.0 only) 592810-001
e HD5430 PCA Discrete system board with modem and card reader (for model 1.0 592811-001
only)
e  HD545V PCA Discrete system board (for model 1.0 only) 611554-001
e HD545V PCA Discrete system board with card reader (for model 1.0 only) 611555-001
e HD5470/512M PCA Discrete system board (for model 1.1 only) 616405-001
e HD5470/512M PCA Discrete system board with card reader (for model 1.1 only) 616406-001
e HD5470/1G PCA Discrete system board (for model 1.1 only) 616407-001
e HD5470/1G PCA Discrete system board with card reader (for model 1.1 only) 616408-001
e HD6370/512M Discrete system board (for model 1.2 only) 632183-001
e HD6370/512M Discrete system board with card reader (for model 1.2 only) 632184-001
e HD6370/1G Discrete system board (for model 1.2 only) 632185-001
e HD6370/1G Discrete system board with card reader (for model 1.2 only) 632186-001
(11) Memory module (1066 MHz, DDR3)
e 1GB 598859-001
e 2GB 598856-001
e 4 GB (for models 1.1 and 1.2 only) 599092-001
(12) Hard drive
e 750 GB, 5400 rpm (for models 1.0 and 1.2 only) 603787-001
e 640 GB, 5400 rpm 603785-001
e 500 GB, 7200 rpm 634919-001
e 320 GB, 7200 rpm 599055-001
e 250 GB, 7200 rpm 599054-001
e 160 GB, 7200 rpm (for models 1.0 and 1.1 only) 599053-001
e  Hard Drive Hardware Kit (not illustrated, includes bracket and screws) 599057-001
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Item

Description

Spare part number

(13)

Processor (includes replacement thermal material)

e  AMD Phenom N930 Processor (2.0 GHz, 2 MB total L2 cache, 1333 MHz)—Quad 594169-001
core 35 W

e  AMD Phenom N830 Processor (2.1 GHz, 1.5 MB total L2 cache, 1333 MHz)—Triple 594168-001
Core 35 W (for models 1.0 and 1.1 only)

e  AMD Phenom N620 Processor (2.8 GHz, 2 MB total L2 cache, 1333 MHz)—Dual 594166-001
Core 35 W (for models 1.0 and 1.1 only)

e  AMD Phenom Il P920 Processor (1.6 GHz, 2 MB total L2 cache, 1066 MHz)—Quad 594170-001
Core 25 W (for models 1.0 and 1.1 only)

e  AMD Phenom Il P820 Processor (1.8 GHz, 1.5 MB L2 cache, 1066 MHz, 3.6 GT/s)  594167-001
—Triple Core 25 W (for models 1.0 and 1.1 only)

e  AMD Turion Il N530 Processor (2.5 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)— 594172-001
Dual Core 35 W (for models 1.0 and 1.1 only)

e  AMD Turion Il P520 Processor (2.3 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)— 594173-001
Dual Core 25 W (for models 1.0 and 1.1 only)

e  AMD Athlon Il N330 Processor (2.3 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)— 594164-001
Dual Core 35 W (for model 1.0 only)

e  AMD Athlon Il P320 Processor (2.1 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)— 594165-001
Dual Core 25 W (for models 1.0 and 1.1 only)

e  AMD Sempron Il V120 Processor (2.2 GHz, 512 MB L2 cache, 1066 MHz, 3.2 GT/s) 594171-001
—Single Core 25 W (for model 1.0 only)

e  AMD Athlon Il P340 Processor (2.2 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)— 616343-001
Dual Core 25 W (for models 1.1 and 1.2 only)

e  AMD Athlon Il N350 Processor (2.4 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)— 616334-001
Dual Core 35 W (for models 1.1 and 1.2 only)

e  AMD Turion Il P540 Processor (2.4 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)— 616347-001
Dual Core 25 W (for model 1.1 only)

e  AMD Turion Il N550 Processor (2.6 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)— 616337-001
Dual Core 35 W (for models 1.1 and 1.2 only)

e  AMD Phenom Il N640 Processor (2.9 GHz, 2 MB total L2 cache, 1066 MHz)—Quad 616344-001
Core 35 W (for models 1.1 and 1.2 only)

e  AMD Phenom Il P840 Processor (1.9 GHz, 2 MB total L2 cache, 1066 MHz) (for 616335-001
models 1.1 and 1.2 only)

e  AMD Phenom Il N850 Processor (2.2 GHz, 2 MB total L2 cache, 1066 MHz) (for 616345-001
models 1.1 and 1.2 only)

e  AMD Phenom Il P940 Processor (1.7 GHz, 1.5 MB L2 cache, 1066 MHz, 3.6 GT/s)  616336-001
(for models 1.1 and 1.2 only)

e  AMD Phenom Il P950 Processor (2.1 GHz, 1.5 MB L2 cache, 1066 MHz, 3.6 GT/s)  616346-001
—Triple Core 35 W (for models 1.1 and 1.2 only)

e  AMD Turion Il P560 Processor (2.5 GHz, 2 MB L2 cache 1066 MHz)-Dual core 35 634691-001
W (for model 1.2 only)

e  AMD Athlon Il N370 Processor (2.5 GHz, 1 MB L2 cache 1066 MHz)-Dual core 35 634686-001

W (for model 1.2 only)
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Spare part number

AMD Turion 1l N570 Processor (2.7 GHz, 2 MB L2 cache 1066 MHz)-Dual core35 W
(for model 1.2 only)

634690-001

AMD Phenom Il N970 Processor (2.2 GHZ 2 MB L2 cache 1333 MHz)—Quad core
(for model 1.2 only)

645496-001

AMD Phenom Il P960 Processor (1.8 GHZ 2 MB L2 cache 1066 MHz)-Quad core 25
W (for model 1.2 only)

634689-001

AMD Phenom Il N870 Processor (2.3 GHZ 1.5 MB L2 cache 1333 MHz)—Triple
core (for model 1.2 only)

635495-001

AMD Phenom Il P860 Processor (2 GHZ 1.5 MB L2 cache 1066 MHz)-Triple core
25 W (for model 1.2 only)

634688-001

AMD Phenom Il N660 Processor (3.0 GHz 2 MB L2 cache 1333 MHz)—Dual core
35 W (for model 1.2 only)

635494-001

AMD Phenom Il P650 Processor (2.6 GHZ 2 MB L2 cache)-25 W (for model 1.2
only)

634687-001

AMD Athlon Il P360 Discrete Processor (2.3 GHz 1.0 MB L2 cache 1066 MHz)-Dual
core 35 W (for model 1.2 only)

636635-001

AMD Champlain V160 Processor (2.4 GHz 512 MB L2 cache 1066 MHz)-Single
core 25 W (for model 1.2 only)

636634-001

(14)

Wireless (WLAN) module

Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Canada, the Cayman
Islands, Guam, Puerto Rico, the United States, and the US Virgin Islands

580101-001

Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Afghanistan, Albania,
Algeria, Andorra, Angola, Antigua and Barbuda, Argentian, Armenia, Australia,
Austria, AzerbaijanBahamas, Bahrain, Barbados, Belgium, Belize, Benin, Bhutan,
Bosnia and Herzegovina, Botswana, Brazil, Brunei, Bulgeria, Burkina Faso, Burundi,
Cambodia, Cameroon, Cape Verde, Central African Republic, Chad, Chile, China,
Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, Czech Republic, Zaire,
Denmark, Djibouti, Dominica, Dominican Republic, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India,
Indonesia, Ireland, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya,
Kiribati, Korea-South, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Martinique, Nether Antilles, French Guiana, Aruba, British Virgin Islands, Bermuda,
Syria, Guadeloupe, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagaascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall Islands,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea,
Paraguay, Peru, Philippines, Poland, Portugal, Republic of Moldova, Romania,
rwanda, Samoa, San Marino, Sao tome and Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon
Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Thailand, Timor (East), Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, United Arab Emirates ,United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zambia, and
Zimbabwe

580101-002

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter (for models 1.0 and 1.1 only)

593533-001

Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter

593836-001
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e  Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter 600370-001
(BT3.0+HS ready)
e Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter 602992-001
(BT3.0+HS ready)
(15) Optical drive (includes optical drive bezel and bracket)
DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use
with:
e  Biscotti computer models 599062-001
e  Matte black computer models 600651-001
e  Silver computer models (for model 1.0 only) 608112-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 615588-001
e  Imperial blue computer models (for models 1.1 and 1.2 only) 622565-001
Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with:
e  Biscotti computer models 599063-001
e  Matte black computer models 600652-001
e  Silver computer models (for model 1.0 only) 608114-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 615589-001
e  |mperial blue computer models (for models 1.1 and 1.2 only) 622566-001
(16) Battery
e  6-cell Li-lon, 2.20 Ah, 47 Wh 593553-001
e  6-cell Li-lon, 2.55 Ah, 55 Wh 593554-001
17) Power connector (includes cable) 602743-001
(18) USB board 595205-001
(19) RJ-11 connector included in Cable Kit 595201-001
(20) Base enclosure
e  With HDMI card reader for biscotti computer models 617019-001
e  Without card reader for biscotti computer models 617020-001
e  With HDMI card reader for matte black computer models 617021-001
e  Without card reader for matte black computer models 617022-001
e  With HDMI card reader for silver computer models (for model 1.0 only) 617023-001
e  With HDMI card reader for charcoal computer models (for models 1.1 and 1.2 only)  615591-001
e  With HDMI card reader for imperial blue computer models (for models 1.1 and 1.2 622568-001
only)
Rubber Kit (not illustrated, includes four rubber feet) 600849-001
Plastics Kit 595200-001
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(21) e  Hard drive cover

(22) e  Memory module cover
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Item Description Spare part number
(1) Display bezel

e  Presario CQ62 with webcam and microphone modules 595190-001

e  Presario CQ62 with microphone module only 595189-001

e HP G62 with webcam and microphone modules 595193-001

e  HP G62 with microphone module only 595192-001
(2) Display bracket (with hinges) 595195-001

ENWW
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Item Description Spare part number
(3) 39.6-cm (15.6-in) high definition, Brightview, display panel (includes display panel 595130-001
cable)
(4) Webcam module 600166-001
Display cable kit 595196-001
(5) Wireless antenna (includes wireless antenna transceivers and cable)
Webcam cable
Display cable
(6) Display back cover (includes logo) for use with:
e  HP G62 biscotti computer models 595191-001
e  HP G62 silver computer models (for model 1.0 only) 605145-001
e  HP G62 charcoal computer models (for models 1.1 and 1.2 only) 615585-001
e  HP G62 imperial blue computer models (for models 1.1 and 1.2 only) 622564-001
e  HP G62 matte black computer models (for model 1.0 only) 608111-001
e  Presario CQ62 biscotti computer models 602172-001
e  Presario CQ62 matte black computer models 595194-001
(7) Display hinge covers 600650-001
Display screw kit (not illustrated) 595197-001
Display rubber display kit (not illustrated, includes display bezel rubber screw covers) 595198-001
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Item  Description Spare part number
Plastics kit 595200-001
(1) Hard drive bay cover (includes captive screws)
(2) Wireless/memory module mini-card compartment cover (includes captive screw)
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Mass storage devices

Item

Description

Spare part number

Optical drive (12.7 mm, SATA, fixed, includes bezel and bracket)

DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use

with:

e  Biscotti computer models 599062-001
e  Matte black computer models 600651-001
e  Silver computer models (for model 1.0 only) 608112-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 615588-001
e  Imperial blue computer models (for models 1.1 and 1.2 only) 622565-001
Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with:

e  Biscotti computer models 599063-001
e  Matte black computer models 600652-001
e  Silver computer models (for model 1.0 only) 608114-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 615589-001
e  |mperial blue computer models (for models 1.1 and 1.2 only) 622566-001

(2) Hard drive

e  750-GB 5400 RPM (for models 1.1 and 1.2 only) 603787-001
e  640-GB 5400 RPM 603785-001
e 500-GB 7200 RPM 634919-001
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e  320-GB 7200 RPM 599055-001
e  250-GB 7200 RPM 599054-001
e  160-GB 7200 RPM (for models 1.0 and 1.1 only) 599053-001
Hard drive hardware kit (not illustrated, includes bracket and screws) 600191-001
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Description

Spare part number

AC adapters

65-W AC adapter

613152-001

90-W AC adapter

613153-001

Power cord, AC, 3 wire, black, 1.83-m (for use with both HP G62 and Presario CQ 62 computer models) for use in:

e  Australia 490371-011
e India 490371-D61
e  Japan (for models 1.1 and 1.2 only) 490371-291
e Korea 490371-AD1
e  North America 490371-001
e the People’s Republic of China 490371-AA1
e Taiwan 490371-AB1
e  Thailand 490371-201
Cable Kit 595201-001
e  Hard drive connector cable

e  Optical drive connector cable

e  Power button cable

e RJ-11cable

e  TouchPad button board cable

e  TouchPad cable

e USB cable

Rubber kit 600184-001
Screw kit 595202-001

Phillips M2.0x3.0 screw
Phillips M2.5x3.0 screw
Phillips M2.5x4.0 screw
Phillips M2.5x5.0 screw

Phillips M2.5x6.5 screw
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Spare part number Description

490371-001 Power cord for use in North America

490371-011 Power cord for use in Australia

490371-201 Power cord for use in Thailand

490371-291 Power cord for use in Japan (for models 1.1 and 1.2 only)

490371-AA1 Power cord for use in the People’s Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in Korea

490371-D61 Power cord for use in India

510100-001 56K V.92 data/fax modem (select models only, for use in all countries and regions except for

Australia and New Zealand) (for model 1.0 only)

510100-011 56K V.92 data/fax modem (select models only, for use in Australia and New Zealand) (for model
1.0 only)
580101-001 Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Canada, the Cayman Islands,

Guam, Puerto Rico, the United States, and the US Virgin Islands

580101-002 Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentian, Armenia, Australia, Austria, Azerbaijan,
Bahamas, Bahrain, Barbados, Belgium, Belize, Benin, Bhutan, Bosnia and Herzegovina,
Botswana, Brazil, Brunei, Bulgeria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde,
Central African Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia,
Cyprus, Czech Republic, Zaire, Denmark, Djibouti, Dominica, Dominican Republic, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guatemala, Guinea, Guinea-
Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Italy,
Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Korea-South, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Martinique, Nether Antilles, French
Guiana, Aruba, British Virgin Islands, Bermuda, Syria, Guadeloupe, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagaascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall
Islands, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, Peru, Philippines, Poland,
Portugal, Republic of Moldova, Romania, rwanda, Samoa, San Marino, Sao tome and Principe,
Saudi Arabia, Senegal, Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts and Nevis, St.
Lucia, St. Vincent and Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Thailand, Timor (East), Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, United Arab Emirates ,United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zambia, and Zimbabwe

592808-001 PCA UMA system board

592809-001 PCA UMA system board with modem and card reader

592810-001 HD5430 PCA Discrete system board (for model 1.0 only)

592811-001 HD5430 PCA Discrete system board with modem and card reader (for model 1.0 only)
593533-001 Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter (for models 1.0 and 1.1 only)
593553-001 Battery, 6-cell, 2.20 Ah, 47 Wh

593554-001 Battery, 6-cell, 2.55 Ah, 55 Wh
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593836-001 Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter

594164-001 AMD Athlon 11 N330 Processor (2.3 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)—Dual Core 35
W (for model 1.0 only)

594165-001 AMD Athlon Il P320 Processor (2.1 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)—Dual Core 25
W (for models 1.0 and 1.1 only)

594166-001 AMD Phenom N620 Processor (2.8 GHz, 2 MB total L2 cache, 1333 MHz)—Dual Core 35 W
(for models 1.0 and 1.1 only)

594167-001 AMD Phenom Il P820 Processor (1.8 GHz, 1.5 MB L2 cache, 1066 MHz, 3.6 GT/s)—Triple
Core 25 W (for models 1.0 and 1.1 only)

594168-001 AMD Phenom N830 Processor (2.1 GHz, 1.5 MB total L2 cache, 1333 MHz)—Triple Core 35 W
(for models 1.0 and 1.1 only)

594169-001 AMD Phenom N930 Processor (2.0 GHz, 2 MB total L2 cache, 1333 MHz)—Quad core 35 W

594170-001 AMD Phenom Il P920 Processor (1.6 GHz, 2 MB total L2 cache, 1066 MHz)—Quad Core 25 W
(for models 1.0 and 1.1 only)

594171-001 AMD Sempron Il V120 Processor (2.2 GHz, 512 MB L2 cache, 1066 MHz, 3.2 GT/s)—Single
Core 25 W (for model 1.0 only)

594172-001 AMD Turion Il N530 Processor (2.5 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)—Dual Core 35
W (for models 1.0 and 1.1 only)

594173-001 AMD Turion Il P520 Processor (2.3 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)—Dual Core 25
W (for models 1.0 and 1.1 only)

595130-001 High Definition display panel (includes display panel and backlight cables)

595185-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 biscotti computer
models

595186-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 biscotti computer
models with webcam

595187-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for Presario CQ62 matte black
computer models

595188-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for Presario CQ62 matte black
computer models with webcam

595189-001 Display bezel for use with Presario CQ62 with microphone module only

595190-001 Display bezel for use with Presario CQ62 with webcam and microphone modules

595191-001 Display enclosure for use with HP G62 biscotti computer models

595192-001 Display bezel for use with HP G62 with microphone module only

595193-001 Display bezel for use with HP G62 with webcam and microphone modules

595194-001 Display enclosure for use with Presario CQ62 matte black computer models

595195-001 Display hinge kit (includes left and right display hinges)

595196-001 Wireless antenna kit (includes wireless antenna transceivers and cable)

595197-001 Display screw kit

595198-001 Display rubber kit

595199-001 Keyboard for use in North America (includes keyboard cable)
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595199-121 Keyboard for use in Canada (includes keyboard cable)

595199-281 Keyboard for use in Thailand (includes keyboard cable)

595199-291 Keyboard for use in Japan (includes keyboard cable) (for models 1.1 and 1.2 only)

595199-AB1 Keyboard for use in Taiwan (includes keyboard cable)

595199-AD1 Keyboard for Korea (includes keyboard cable)

595200-001 Plastics kit

595201-001 Cable kit

595202-001 Screw kit

595203-001 Touchpad button board

595204-001 Power button board

595205-001 USB board

595206-001 Top cover (includes TouchPad board) for use in biscotti computer models

595207-001 Top cover (includes TouchPad board) for use in matte black computer models

598856-001 2 GB memory module (1066 MHz, DDR3)

598859-001 1 GB memory module (1066 MHz, DDR3)

599053-001 160 GB, 7200 rpm hard drive (for models 1.1 and 1.2 only)

599054-001 250 GB, 7200 rpm hard drive

599055-001 320 GB, 7200 rpm hard drive

599057-001 Hard Drive Hardware Kit (includes bracket and screws)

599062-001 DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with
biscotti computer models

599063-001 Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with biscotti
computer models

599092-001 4 GB memory module (1066 MHz, DDR3) (for models 1.1 and 1.2 only)

600166-001 Webcam module

600370-001 Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter
(BT3.0+HS ready)

600650-001 Display hinge covers

600651-001 DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with
matte black computer models

600652-001 Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with matte
black computer models

600849-001 Rubber kit (includes four rubber feet)

602170-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for Presario CQ62 biscotti computer
models

602171-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for Presario CQ62 biscotti computer

models with webcam
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Spare part number

Description

602172-001 Display enclosure for use with Presario CQ62 biscotti computer models

602743-001 Power connector (includes cable)

602744-001 Speaker assembly (includes cable)

602745-001 RTC battery

602992-001 Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter (BT3.0+HS
ready)

603785-001 640 GB, 5400 rpm hard drive

603787-001 750 GB, 5400 rpm hard drive (for models 1.0 and 1.2 only)

605141-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 silver computer models
(for model 1.0 only)

605142-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 silver computer models
with webcam (for model 1.0 only)

605145-001 Display enclosure for use with HP G62 silver computer models (for model 1.0 only)

605147-001 Top cover (includes TouchPad board) for use in silver computer models (for model 1.0 only)

606609-001 Fan/heat sink assembly (includes replacement thermal material) for use with UMA systems

606610-001 Fan/heat sink assembly (includes replacement thermal material) for use with discrete systems

608109-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 matte black computer
models (for model 1.0 only)

608110-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 matte black computer
models with webcam (for model 1.0 only)

608111-001 Display enclosure for use with HP G62 matte black computer models (for model 1.0 only)

608112-001 DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with
silver computer models (for model 1.0 only)

608114-001 Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with silver
computer models (for model 1.0 only)

611554-001 HD545V PCA Discrete system board (for model 1.0 only)

611555-001 HD545V PCA Discrete system board with card reader (for model 1.0 only)

613152-001 65-W AC adapter

613153-001 90-W AC adapter

613161-001 65-W AC smart adapter

615583-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 charcoal computer
models (for models 1.1 and 1.2 only)

615584-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 charcoal computer
models with webcam (for models 1.1 and 1.2 only)

615585-001 Display enclosure for use with HP G62 charcoal computer models (for models 1.1 and 1.2 only)

615588-001 DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with
charcoal computer models (for models 1.1 and 1.2 only)

615589-001 Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with charcoal

computer models (for models 1.1 and 1.2 only)
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Spare part number Description

615590-001 Top cover (includes TouchPad board) for use in charcoal computer models (for models 1.1 and
1.2 only)

615591-001 Base enclosure with HDMI card reader (for models 1.1 and 1.2 only)

616334-001 AMD Athlon Il N350 Processor (2.4 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)—Dual Core 35
W (for models 1.1 and 1.2 only)

616333-001 V140 discrete processor 2.3 GHz 25 W (for models 1.1 and 1.2 only)

616335-001 AMD Phenom Il P840 Processor (1.9 GHz, 2 MB total L2 cache, 1066 MHz) (for models 1.1 and
1.2 only)

616336-001 AMD Phenom Il P940 Processor (1.7 GHz, 1.5 MB L2 cache, 1066 MHz, 3.6 GT/s) (for models
1.1 and 1.2 only)

616337-001 AMD Turion Il N550 Processor (2.6 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)—Dual Core 35
W (for models 1.1 and 1.2 only)

616343-001 AMD Athlon Il P340 Processor (2.2 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)—Dual Core 25
W (for models 1.1 and 1.2 only)

616344-001 AMD Phenom Il N640 Processor (2.9 GHz, 2 MB total L2 cache, 1066 MHz)—Quad Core 35 W
(for models 1.1 and 1.2 only)

616345-001 AMD Phenom Il N850 Processor (2.2 GHz, 2 MB total L2 cache, 1066 MHz) (for models 1.1
and 1.2 only)

616346-001 AMD Phenom Il P950 Processor (2.1 GHz, 1.5 MB L2 cache, 1066 MHz, 3.6 GT/s)—Triple
Core 35 W (for models 1.1 and 1.2 only)

616347-001 AMD Turion Il P540 Processor (2.4 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)—Dual Core 25
W (for model 1.1 only)

616405-001 HD5470/512M PCA Discrete system board(for model 1.1 only)

616406-001 HD5470/512M PCA Discrete system board with card reader (for model 1.1 only)

616407-001 HD5470/1G PCA Discrete system board (for model 1.1 only)

616408-001 HD5470/1G PCA Discrete system board with card reader (for model 1.1 only)

617019-001 Base enclosure with HDMI card reader for biscotti computer models

617020-001 Base enclosure for biscotti computer models

617021-001 Base enclosure with HDMI card reader for matte black computer models

617022-001 Base enclosure for matte black computer models

617023-001 Base enclosure with HDMI card reader for silver computer models (for model 1.0 only)

617029-001 Fan/heat sink assembly (includes replacement thermal material) for use with HD545V discrete

systems (for model 1.1 only)

622562-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 imperial blue computer
models (for models 1.1 and 1.2 only)

622563-001 39.6-cm (15.6-in) HD, light-emitting diode display assembly for HP G62 imperial blue computer
models with webcam (for models 1.1 and 1.2 only)

622564-001 Display enclosure for use with HP G62 imperial blue computer models (for models 1.1 and 1.2
only)

622565-001 DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with

imperial blue computer models (for models 1.1 and 1.2 only)
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Spare part number

Description

622566-001 Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with imperial
blue computer models (for models 1.1 and 1.2 only)

622567-001 Top cover (includes TouchPad board) for use in imperial blue computer models (for models 1.1
and 1.2 only)

622568-001 Base enclosure with HDMI card reader for imperial blue computer models (for models 1.1 and
1.2 only)

632183-001 HD6370/512M Discrete system board (for model 1.2 only)

632184-001 HD6370/512M Discrete system board with card reader (for model 1.2 only)

632185-001 HD6370/1G Discrete system board (for model 1.2 only)

632186-001 HD6370/1G Discrete system board with card reader (for model 1.2 only)

634686-001 AMD Athlon Il N370 Processor (2.5 GHz, 1 MB L2 cache 1066 MHz)-Dual core 35 W (for model
1.2 only)

634687-001 AMD Phenom Il P650 Processor (2.6 GHZ 2 MB L2 cache)—2W (for model 1.2 only)

634688-001 AMD Phenom Il P860 Processor (2 GHZ 1.5 MB L2 cache 1066 MHz)-Triple core 25 W (for
model 1.2 only)

634689-001 AMD Phenom Il P960 Processor (1.8 GHZ 2 MB L2 cache 1066 MHz)-Quad core 25 W (for
model 1.2 only)

634690-001 AMD Turion 1l N570 Processor (2.7 GHz, 2 MB L2 cache 1066 MHz)-Dual core35 W (for model
1.2 only)

634691-001 AMD Turion Il P560 Processor (2.5 GHz, 2 MB L2 cache 1066 MHz)-Dual core 35 W (for model
1.2 only)

634919-001 500 GB, 7200 rpm hard drive

635494-001 AMD Phenom Il N660 Processor (3.0 GHz 2 MB L2 cache 1333 MHz)—Dual core 35 W (for
model 1.2 only)

635495-001 AMD Phenom Il N870 Processor (2.3 GHZ 1.5 MB L2 cache 1333 MHz)—Triple core (for model
1.2 only)

636634-001 AMD Champlain V160 Processor (2.4 GHz 512 MB L2 cache 1066 MHz)-Single core 25 W (for
model 1.2 only)

636635-001 AMD Athlon Il P360 Discrete Processor (2.3 GHz 1.0 MB L2 cache 1066 MHz)-Dual core 35 W
(for model 1.2 only)

645496-001 AMD Phenom Il N970 Processor (2.2 GHZ 2 MB L2 cache 1333 MHz)—Quad core (for model

1.2 only)
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e  Flat-bladed screwdriver
e  Magnetic screwdriver

e  Phillips PO and P1 screwdrivers

Service considerations

Before disassembly or assembly procedures, review and adhere to all service considerations.

B NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when

handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions..
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Cables and connectors

/A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

/A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage might have occurred.

An electronic device exposed to ESD might not be affected at all and can work perfectly throughout a
normal cycle. Or the device might function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when removing or installing internal components,
observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/A CAUTION: A product can be degraded by as little as 700 V.

ENWW

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000V
Motions of bench worker 6,000 V 800V 400 V
Removing DIPS from plastic tube 2,000 V 700V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.
Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

e  When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm +£10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

e  When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e Antistatic tape

e Antistatic smocks, aprons, and sleeve protectors

e  Conductive bins and other assembly or soldering aids

e  Nonconductive foam

e  Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e Field service kits

e  Static awareness labels

e Material-handling packages

e Nonconductive plastic bags, tubes, or boxes

e Metal tote boxes

e Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 75 screws, in 12 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and

replacement.

Serial number

The serial number label, located in the battery bay of the computer, provides important information
that you may need when contacting technical support.

-II BRI LA

(1) Product name (4) Warranty period

(2) Serial number (5) Model description (select models)

(3) Product number
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Computer feet

Description Spare part number

Rubber Feet Kit 600849-001

The computer feet are adhesive-backed rubber pads. The feet attach to the base enclosure in the
locations illustrated below.
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Battery

Description Spare part number
6 cell, 2.20-Ah, 47 Wh 593553-001
6 cell, 2.55-Ah, 55 Wh 593554-001

Before disassembling the computer:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside down on a flat surface.
2. Slide the battery release latch (1) to release the battery.

3. Pivot the battery (2) upward and lift it out of the computer (3).

To insert the battery, insert the rear edge of the battery into the battery bay and pivot the front edge
downward until the battery is seated. The battery release latch automatically locks the battery into
place.
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Hard drive

Br NOTE: The hard drive spare part kit includes a hard drive bracket and hard drive connector. The
hard drive bracket and hard drive connector, as well as the hard drive bracket screws, are also
available in the Hard Drive Hardware Kit.

ENWW

Description Spare part number
750 GB; 5400 RPM (for models 1.1 and 1.2 only) 603787-001
640 GB; 5400 RPM 603785-001
500 GB; 7200 RPM 634919-001
320 GB; 7200 RPM 599055-001
250 GB; 7200 RPM 599054-001
160 GB; 7200 RPM (for models 1.0 and 1.2 only) 599053-001
Hard drive hardware kit (not illustrated, includes connector, bracket, and screws) 599057-001

Before removing the hard drive:

1.

4,

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 46).

Remove the hard drive:

1.
2.

Position the computer with the front toward you.

Loosen the two Phillips PM2.5%6.0 captive screws (1) that secure the hard drive cover to the
computer.
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3. Lift the left side of the hard drive cover (2), swing it forward, and remove the cover (3). The hard
drive cover is included in the plastics kit, spare part number 595200-001.

4. Remove the three Phillips PM2.5x5.0 screws (1) that secure the hard drive to the computer.

5. Use the hard drive bracket to lift the hard drive out (2) of the hard drive compartment.

6. Disconnect the hard drive cable from the system board (3).
7. Remove the hard drive (4) from the hard drive bay.

8. Toreplace the hard drive bracket, remove the four Phillips PM3.0%4.0 screws (1) that secure the
hard drive bracket to the hard drive
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9. Grasp the two attached Mylar tabs and pull the bracket straight up to remove it from the hard
drive (2).

Reverse this procedure to install the hard drive.
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Optical drive

B NOTE: The optical drive spare part kit includes an optical drive bezel and optical drive bracket.

Description Spare part
number

DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with:

e  Biscotti computer models 599062-001
e  Matte black computer models 600651-001
e  Silver computer models (for model 1.0 only) 608112-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 615588-001
e  |mperial blue computer models (for models 1.1 and 1.2 only) 622565-001

Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with:

e  Biscotti computer models 599063-001
e  Matte black computer models 600652-001
e  Silver computer models (for model 1.0 only) 608114-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 615589-001
e  Imperial blue computer models (for models 1.1 and 1.2 only) 622566-001

Before removing the optical drive:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the hard drive (see Hard drive on page 47).

Remove the optical drive:
1. Position the computer upside down with the front toward you.

2. Insert a thin tool, such as a screw driver (1), into the release access slot in the hard drive bay.
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3. Grasp the bezel and slide the optical drive out of the computer (2).

4. To replace the optical drive bracket, position the optical drive with the optical drive bracket
toward you.

5. Remove the two Phillips PM2.0%3.0 screws (1) that secure the optical drive bracket to the optical
drive.

6. Remove the optical drive bracket (2).

—
T

Mg

Reverse the above procedure to reassemble and install the optical drive.
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WLAN module

Description Spare part
number
Atheros AR9285 802.11 a/b/g/n 2x2 WiFi 580101-001
Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter 580101-002
Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter 593533-001
Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter 593836-001

Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter (BT3.0+HS ready) 600370-001

Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter (BT3.0+HS ready) 602992-001

Before removing the WLAN module:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).
Remove the WLAN module:
1. Turn the computer upside down with the front toward you.

2. Loosen the three Phillips PM2.5x6.0 captive screws (1) that secure the mini-card compartment
cover.

3.  Lift the back side of the memory module cover (2).
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4. Lift the cover off the computer (3). The mini-card compartment cover is included in the plastics
kit, spare part number 595200-001.

5. Disconnect the main antenna cable (1) and the auxiliary antenna cable (2) from the wireless
module.

6. Remove the Phillips PM2.0%3.0 screw (3) that secures the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)
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7. Remove the WLAN module (4) by pulling it away from the slot at an angle.

/A CAUTION: To prevent an unresponsive system, replace the wireless module only with a
wireless module authorized for use in the computer by the governmental agency that regulates
wireless devices in your country or region. If you replace the module and then receive a warning
message, remove the module to restore computer functionality, and then contact technical
support through Help and Support.

B NOTE: WLAN modules are designed with a notch (5) to prevent incorrect insertion into the
WLAN module slot.

Reverse this procedure to install a WLAN module.
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Memory module

ENWW

Description Spare part number
1 GB, 1066 MHz DDR3 598859-001

2 GB, 1066 MHz DDR3 598856-0011

4 GB, 1066 MHz DDR3 (for models 1.1 and 1.2 only) 599092-0011

Before removing the memory module:

1.

4.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 46).

Remove the memory module:

1.
2.

Turn the computer upside down with the front toward you.

Loosen the three Phillips PM2.5%6.0 captive screws (1) that secure the mini-card compartment
cover to the computer.

Lift the back side of the memory module cover (2)

Lift the cover off the computer (3). The mini-card compartment cover is included in the plastics
kit, spare part number 595200-001.

B NOTE: Small tabs hold the cover in place. Firmly pull up on the cover to release the tabs.
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5. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

6. Remove the module (2) by pulling it away from the slot at an angle.

Br NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Keyboard
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Description Spare part number
For use in Canada 595199-121
For use in Japan (for models 1.1 and 1.2 only) 595199-291
For use in Korea 595199-AD1
For use in North America 595199-001
For use in Taiwan 595199-AB1
For use in Thailand 595199-281

Before removing the keyboard:

1.

5.
6.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 46).

Remove the hard drive (see Hard drive on page 47)

Remove the mini-card compartment cover (see WLAN module on page 52).

Remove the keyboard:

1.
2.

Turn the computer upside down with the front toward you.

Remove the three Phillips PM2.5x5.0 and three Phillips PM2.5x6.5 screws that secure the
keyboard to the computer.
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3. Turn the computer display-side up with the front toward you.
4. Open the computer as far as possible.

5. Release the tabs along the left (1) and right (2) edges of the keyboard using a thin flat-bladed
screwdriver.

6. Lift the rear edge of the keyboard (3), and set the keyboard back towards the display (4).

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover

ENWW

Description Spare part number
For use with biscotti computer models 595206-001
For use with matte black computer models 595207-001
For use with silver computer models (for model 1.0 only) 605147-001
For use with charcoal computer models (for models 1.1 and 1.2 only) 615590-001
For use with imperial blue computer models (for models 1.1 and 1.2 only) 622567-001

Before removing the switch cover:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting AC adapter from the computer.

Remove the following components:

a.

b.

e.

f.

Battery (see Battery on page 46).

Hard drive (See Hard drive on page 47).

Optical drive (see Optical drive on page 50).

WLAN module (see WLAN module on page 52).

Memory module (see Memory module on page 55).

Keyboard (see Keyboard on page 57).

Remove the switch cover:

1.

Turn the computer upside down with the front toward you.
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2. Remove four Phillips PM2.5x3 screws in the battery bay, and remove ten Phillips PM2.5x6.5
screws on the base enclosure. The top cover screws are identified by a triangle icon embossed
on the base enclosure.

3. Turn the computer display-side up with the front toward you.
4. Open the computer as far as possible.

5.  Remove the Phillips PM2.5%6.0 screw that secures the top cover to the computer.
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6. Release the power button ZIF connector (1), speaker cable (2), touchpad ZIF connector (3), and
touchpad button ZIF connector (4).

7. Lift the rear edge of the top cover (1) until the top cover disengages from the base enclosure.
Remove the top cover (2).

Er NOTE: The TouchPad is glued to the top cover and is included with the top cover spare part.

Reverse this procedure to install the switch cover.
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Speaker assembly

Description Spare part number

Speaker assembly (includes cable) 602744-001

Before removing the speaker assembily:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Optical drive (see Optical drive on page 50)

b. Keyboard (see Keyboard on page 57)

c. Top cover (see Top cover on page 59)

Remove the speaker assembly:
1. Turn the top cover upside down.

2. Remove the three Phillips PM2.5%3.0 screws (1) that secure the speaker assembly to the top
cover.

3. Lift up and remove the speakers (2).

Reverse this procedure to install the speaker assembly.
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Power button board
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Description Spare part number

Power button board 595204-001

Before removing the power button board:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a.
b.
c.

d.

Hard drive (see Hard drive on page 47)

Optical drive (see Optical drive on page 50)

Keyboard (see Keyboard on page 57)

Top cover (see Top cover on page 59)

Remove the power button board:

1. Turn the top cover upside down with the rear edge toward you.

2.  Remove the Phillips PM2.0x3.0 screw (1) that secures the power button board to the top cover.

3. Lift up and remove the power button board (2).

o ‘e
A

Reverse this procedure to install the power button board.
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TouchPad button board

Description Spare part number

Touchpad button board 595203-001

Before removing the TouchPad button board:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 46).

Remove the following components:

a.
b.
c.

d.

Hard drive (see Hard drive on page 47)

Optical drive (see Optical drive on page 50)

Keyboard (see Keyboard on page 57)

Top cover (see Top cover on page 59)

Remove the TouchPad button board:

1.
2,

Turn the top cover upside down with the front toward you.

Remove the two Phillips PM2.0x3.0 screws (1) that secure the TouchPad board to the top cover.

Lift up and remove the touchpad button board (2) from the TouchPad bracket.

Reverse the above procedure to reassemble and install the TouchPad button board.
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Modem module
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Description Spare part number
All countries and regions except for Australia and New Zealand (for model 1.0 only) 510100-001
Australia and New Zealand (for model 1.0 only) 510100-011

Before removing the modem module:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a.
b.
c.

d.

Hard drive (see Hard drive on page 47)

Optical drive (see Optical drive on page 50)

Keyboard (see Keyboard on page 57)

Top cover (see Top cover on page 59)

Remove the modem module:

1. Turn the computer upright with the front toward you.

2. Remove the two Phillips PM2.0x3.0 screws (1) that secure the modem module to the system
board.
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3.  Lift up on the front of the modem module (2) to disconnect it from the system board.

Reverse the above procedure to install the modem module, and be sure that the connector on the
bottom of the modem module connects firmly into the system board.
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USB board

Description Spare part number

USB board 595205-001

Before removing the USB board:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 50)

c. Keyboard (see Keyboard on page 57)

d. Top cover (see Top cover on page 59)

Remove the USB board:
1. Position the computer upright with the right side toward you.
Disconnect the USB board cable (1) from the system board.

2
3.  Remove the Phillips PM2.5%6.0 screw (2) that secures the USB board to the base enclosure.
4

Lift the USB board (3) straight up to remove it from the computer. The USB cable is available
with the cable kit using spare part number 595201-001

1— ©
|
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Reverse this procedure to install the USB board.
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Power connector

ENWW

Description Spare part number

Power connector (includes cable) 602743-001

Before removing the power connector cable:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a.
b.
c.

d.

Hard drive (see Hard drive on page 47)

Optical drive (see Optical drive on page 50)

Keyboard (see Keyboard on page 57)

Top cover (see Top cover on page 59)

Remove the power connector cable:

1. Turn the computer upright with the right side toward you.

2. Disconnect the power connector cable (1) from the system board.

3. Lift the power connector (2) from the clips built into the base enclosure.

Reverse this procedure to install the power connector.
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Display assembly

Description

Spare part number

39.6-cm (15.6-in) High Definition (HD), light-emitting diode (LED) display assembly for use in:

e HP G62 computer biscotti computer models 595185-001
e  HP G62 computer biscotti computer models with webcam 595186-001
e  HP G62 silver computer models (for model 1.0 only) 605141-001
e  HP G62 silver computer models with webcam (for model 1.0 only) 605142-001
e HP G62 matte black computer models (for model 1.0 only) 608109-001
e  HP G62 matte black computer models with webcam (for model 1.0 only) 608110-001
e  Presario CQ62 biscotti computer models 602170-001
e  Presario CQ62 biscotti computer models with webcam 602171-001
e  Presario CQ62 matte black computer models 595187-001
e  Presario CQ62 matte black computer models with webcam 595188-001
e HP G62 charcoal computer models (for models 1.1 and 1.2 only) 615583-001
e HP G62 charcoal computer models with webcam (for models 1.1 and 1.2 only) 615584-001
e  HP G62 imperial blue computer models (for models 1.1 and 1.2 only) 622562-001
e  HP G62 imperial blue computer models with webcam (for models 1.1 and 1.2 only) 622563-001

Before removing the display assembly:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on

the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC

outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 46).

Disconnect the wireless antenna cables from the WLAN module (see WLAN module

on page 52).

Remove the following components:

a. Optical drive (see Optical drive on page 50)

b. Keyboard (see Keyboard on page 57)

c. Top cover (see Top cover on page 59)

Remove the display assembly:

1.
2.

Turn the computer display-side up, with the front toward you.

Open the display as far as possible.
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3. Disconnect the display panel cable (1) and the microphone cable (2) from the system board and
remove it from its routing channel.

4. Pull the antenna cables through the opening in the top cover (3) and disengage the cables from
the clip in the routing channel leading to the display hinge (4).

5. Disconnect the webcam cable (5) from the system board and release it from the clips that attach
it to the system board.

/A CAUTION: Support the display assembly when removing the display screws in the following
steps. Failure to support the display assembly can result in damage to the assembly and other
components.

6. Remove the four black Phillips PM2.5x7.0 screws (1) that secure the display assembly to the
computer.
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7. Lift the display panel (2) straight up to remove it.

Reverse this procedure to install the display assembly.

8. Toreplace any of the display assembly internal components, remove the following screw covers
and screws:

(1) Two mylar screw covers on the display bezel bottom edge
(2) Two Phillips PM2.5x4.0 screws

The display screw covers are included in the display screw kit, spare part number 595198-001.

1
T

s
i

9. Flex the inside edge of the top (1), the left and right sides (2), and the bottom (3) of the display
bezel until the bezel disengages from the display back cover.
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10. Remove the display bezel (4).

Reverse this procedure to install the display bezel.

11. To replace the webcam module (select models only), lift the webcam module as far from the
display enclosure as the webcam module cable allows.

12. Disconnect the webcam module cable (1) from the webcam module, and remove the webcam
module (2). The webcam module is available using spare part number 600166-001.

IR &

Reverse this procedure to install the webcam module.

13. To replace the display hinge covers, remove the two Phillips PM2.5%6.0 screws (1) that secure
each hinge to the display enclosure.
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14. Remove the display hinge covers (2). The display hinge covers are available using spare part
number 600650-001.

Reverse this procedure to install the display hinge covers.

15. To replace the display panel, remove eight phillips PM2.5%6.0 screws (1) that secure the display
panel to the display enclosure.

16. Remove the display panel (2) from the display enclosure. The display panel is available using
the spare part number 595130-001.

e

— e — — —————

Reverse this procedure to install the display panel.

17. To replace the display panel brackets, remove the two Phillips PM2.0x3.0 screws (1) that secure
each bracket to the display panel.
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18. Remove the display panel brackets (2) from the display panel. The display panel brackets are
available using spare part number 595195-001.

Reverse this procedure to install the display panel brackets.

19. To replace the wireless antenna transceivers, lift up on the silver transceiver (1) and release the
adhesive material from the display cover (2).

20. Lift up to remove the antenna transceivers (3). The wireless antenna transceivers with cable is
available with the LCD cable kit using spare part number 595196-001..

Reverse this procedure to install the display wireless antenna transceivers.
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System board

Ef NOTE: The system board spare part kit includes UMA or discrete graphics subsystem memory and
replacement thermal material.

Description Spare part number
PCA UMA system board 592808-001
PCA UMA system board with modem and card reader 592809-001
HD5430 PCA Discrete system board (for model 1.0 only) 592810-001
HD5430 PCA Discrete system board with modem and card reader (for model 1.0 only) 592811-001
HD545V PCA Discrete system board (for model 1.0 only) 611554-001
HD545V PCA Discrete system board with card reader (for model 1.0 only) 611555-001
HD5470/512M PCA Discrete system board (for model 1.1 only) 616405-001
HD5470/512M PCA Discrete system board with card reader (for model 1.1 only) 616406-001
HD5470/1G PCA Discrete system board (for model 1.1 only) 616407-001
HD5470/1G PCA Discrete system board with card reader (for model 1.1 only) 616408-001
HD6370/512M Discrete system board (for model 1.2 only) 632183-001
HD6370/512M Discrete system board with card reader (for model 1.2 only) 632184-001
HD6370/1G Discrete system board (for model 1.2 only) 632185-001
HD6370/1G Discrete system board with card reader (for model 1.2 only) 632186-001

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

e RTC battery (see RTC battery on page 79)

e  Memory modules (see Memory module on page 55)

e  WLAN module (see WLAN module on page 52)

e Modem module (see Modem module on page 65)

Before removing the system board:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.
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Remove the battery (see Battery on page 46).

Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 50)

c. Keyboard (see Keyboard on page 57)

d. Top cover (see Top cover on page 59)

e. Speaker assembly (see Speaker assembly on page 62)

f. Display assembly (see Display assembly on page 70)

Remove the following cables from the system board:

P w0 b

Power connector cable (see Power connector on page 69)

USB board cable (see USB board on page 67)

Turn the computer upright with the right side toward you.
Remove the three Phillips PM2.5%4.0 (1) screws that secure the system board to the computer.
Grasp the right edge (2) of the system board.

Lift the system board (3), and pull it away from the base enclosure at an angle.

Reverse this procedure to install the system board.
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5. To replace the modem module cable, remove the RJ-11 connector cable from the clips (1), and

then lift the connector straight up (2) and out of the computer. The modem module cable is
available using spare part number 595201-001.

Reverse this procedure to install the modem module cable.

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

e Fan/heat sink assembly (see Fan/heat sink assembly on page 81)

e  Processor (see Processor on page 85)

Reverse the preceding procedure to install the system board.
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RTC battery

ENWW

Description Spare part number

RTC battery 602745-001

Before removing the RTC battery:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 46).

Remove the following components:

a.

b.

g.
h.

Hard drive (see Hard drive on page 47)

WLAN (see WLAN module on page 52)

Optical drive (see Optical drive on page 50)

Keyboard (see Keyboard on page 57)

Top cover (see Top cover on page 59)

Speaker assembly (see Speaker assembly on page 62)

Display assembly (see Display assembly on page 70)

System board (see System board on page 76)

Remove the RTC battery:

1.
2.

Turn the system board upside down.

Use a sharp, non-conductive tool to release the clip (1) that secures the battery to the system
board.
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3.  Lift the battery (2) out of the computer.

Reverse this procedure to install the RTC battery.
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Fan/heat sink assembly

ENWW

Description Spare part number
Fan/heat sink assembly (includes replacement thermal material) for use only with computer 606609-001

models with UMA graphics subsystem memory

Fan/heat sink assembly (includes replacement thermal material) for use only with computer 606610-001

models with discrete graphics subsystem memory

Fan/heat sink assembly (includes replacement thermal material) for use only with computer 617029-001

models with HD545V discrete systems subsystem memory (for model 1.1 only)

Before removing the fan/heat sink assembly:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on

the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC

outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).
5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 50)

c. Keyboard (see Keyboard on page 57)

d. Top cover (see Top cover on page 59)

e. Speaker assembly (see Speaker assembly on page 62)

f. Display assembly (see Display assembly on page 70)

dg. System board (see System board on page 76)

Remove the fan/heat assembly (fan/heat sink appearance might vary):

NOTE: Steps 1 through 4 apply only to computer models equipped with graphics subsystems

having UMA memory.

1. Turn the system board right-side up, with the front toward you.
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2. Disconnect the fan cable from the system board.

3. Follow the sequence embossed on heat sink to loosen the three Phillips PM2.5x7.0 captive
screws (1) that secure the fan/heat sink assembly to the system board.

Br NOTE: Due to the adhesive quality of the thermal material located between the fan/heat sink
assembly and system board components, it might be necessary to move the fan/heat sink
assembly from side to side to detach the assembly.

4. Remove the fan/heat sink assembly (2) by lifting straight up.

B NOTE: Steps 5 through 8 apply only to computer models equipped with graphics subsystems
having discrete memory.

1. Turn the system board right-side up, with the front toward you.

82 Chapter 4 Removal and replacement procedures ENWW



2. Disconnect the fan cable from the system board.

3. Loosen the three Phillips captive screws (1) and three Phillips spring-loaded captive screws (2)
that secure the fan/heat sink assembly.

Bf NOTE: Due to the adhesive quality of the thermal material located between the fan/heat sink
assembly and system board components, it might be necessary to move the fan/heat sink
assembly from side to side to detach the assembily.

4. Remove the fan/heat sink assembly (3) by lifting straight up.

Reverse this procedure to install the fan/heat sink assembly.

The thermal material must be thoroughly cleaned from the surface of the fan/heat sink assembly (1),
(3) and the processor (2) and video components (4) each time the fan/heat sink assembly is
removed. Thermal pads and thermal paste must be installed on all surfaces before the fan/heat sink
assembly is reinstalled.
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B NOTE: Thermal pads and thermal paste are included with all fan/heat sink assembly, system board,
and processor spare part kits.

The following illustration shows the locations for thermal material on systems with UMA graphics
subsystems.

The thermal material must be thoroughly cleaned from the surface of the fan/heat sink assembly (1)
and (3), and the processor component (2), each time the fan/heat sink assembly is removed. Thermal
pads and thermal paste must be installed on all surfaces before the fan/heat sink assembly is
reinstalled.

The following illustration shows the locations for thermal material on systems with discrete graphics
subsystems.

o

e
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Processor

B NOTE: All processor spare part kits include thermal material.

ENWW

Description Spare part number
AMD Phenom N930 Processor (2.0 GHz, 2 MB total L2 cache, 1333 MHz)—Quad core 35 W 594169-001
AMD Phenom N830 Processor (2.1 GHz, 1.5 MB total L2 cache, 1333 MHz)—Triple Core 35 W 594168-001
AMD Phenom N620 Processor (2.8 GHz, 2 MB total L2 cache, 1333 MHz)—Dual Core 35 W 594166-001
AMD Phenom Il P920 Processor (1.6 GHz, 2 MB total L2 cache, 1066 MHz)—Quad Core 25 W 594170-001
AMD Phenom Il P820 Processor (1.8 GHz, 1.5 MB L2 cache, 1066 MHz, 3.6 GT/s)—Triple Core ~ 594167-001
25W

AMD Turion II N530 Processor (2.5 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)—Dual Core 35 W  594172-001
AMD Turion Il P520 Processor (2.3 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)—Dual Core 25 W  594173-001
AMD Athlon Il N330 Processor (2.3 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)—Dual Core 35 W  594164-001
(for model 1.0 only)

AMD Athlon Il P320 Processor (2.1 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)—Dual Core 25 W  594165-001
AMD Sempron Il V120 Processor (2.2 GHz, 512 MB L2 cache, 1066 MHz, 3.2-GT/s)—Single 594171-001
Core 25 W (for model 1.0 only)

AMD Athlon 1l P340 Processor (2.2 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)—Dual Core 25 W  616343-001
(for model 1.1 only)

AMD Athlon Il N350 Processor (2.4 GHz, 1 MB L2 cache, 1066 MHz, 3.2 GT/s)—Dual Core 35 W  616334-001
(for model 1.1 only)

AMD Turion Il P540 Processor (2.4 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)—Dual Core 25 W  616347-001
(for model 1.1 only)

AMD Turion Il N550 Processor (2.6 GHz, 2 MB L2 cache, 1066 MHz, 3.6 GT/s)—Dual Core 35 W  616337-001
(for model 1.1 only)

AMD Phenom Il N640 Processor (2.9 GHz, 2 MB total L2 cache, 1066 MHz)—Quad Core 35 W 616344-001
(for model 1.1 only)

AMD Phenom Il P840 Processor (1.9 GHz, 2 MB total L2 cache, 1066 MHz) (for model 1.1 only) 616335-001
AMD Phenom Il N850 Processor (2.2 GHz, 2 MB total L2 cache, 1066 MHz) (for model 1.1 only) 616345-001
AMD Phenom Il P940 Processor (1.7 GHz, 1.5 MB L2 cache, 1066 MHz, 3.6 GT/s) (for model 1.1 616336-001
only)

AMD Phenom Il P950 Processor (2.1 GHz, 1.5 MB L2 cache, 1066 MHz, 3.6 GT/s)—Triple Core 616346-001
35 W (for model 1.1 only)

AMD Turion Il P560 Processor (2.5 GHz, 2 MB L2 cache 1066 MHz)-Dual core 35 W (for model 634691-001
1.2 only)

AMD Athlon Il N370 Processor (2.5 GHz, 1 MB L2 cache 1066 MHz)-Dual core 35 W (for model 634686-001
1.2 only)

AMD Turion Il N570 Processor (2.7 GHz, 2 MB L2 cache 1066 MHz)-Dual core35 W (for model 634690-001
1.2 only)

AMD Phenom Il N970 Processor (2.2 GHZ 2 MB L2 cache 1333 MHz)—Quad core (for model 1.2  645496-001

only)
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Description Spare part number

AMD Phenom Il P960 Processor (1.8 GHZ 2 MB L2 cache 1066 MHz)-Quad core 25 W (for model 634689-001

1.2 only)
AMD Phenom Il N870 Processor (2.3 GHZ 1.5 MB L2 cache 1333 MHz)—Triple core (for model 635495-001
1.2 only)
AMD Phenom Il P860 Processor (2 GHZ 1.5 MB L2 cache 1066 MHz)—Triple core 25 W (for 634688-001

model 1.2 only)

AMD Phenom Il N660 Processor (3.0 GHz 2 MB L2 cache 1333 MHz)—Dual core 35 W (for 635494-001
model 1.2 only)

AMD Phenom Il P650 Processor (2.6 GHZ 2 MB L2 cache)-25 W (for model 1.2 only) 634687-001

AMD Athlon 1l P360 Discrete Processor (2.3 GHz 1.0 MB L2 cache 1066 MHz)-Dual core 35 W 636635-001
(for model 1.2 only)

AMD Champlain V160 Processor (2.4 GHz 512 MB L2 cache 1066 MHz)-Single core 25 W (for 636634-001
model 1.2 only)

Before removing the processor:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 46).

Remove the following components:

a.

b.

g.
h.

Hard drive (see Hard drive on page 47)

Optical drive (see Optical drive on page 50)

Keyboard (see Keyboard on page 57)

Top cover (see Top cover on page 59)

Speaker assembly (see Speaker assembly on page 62)

Display assembly (see Display assembly on page 70)

System board (see System board on page 76)

Fan/heat sink assembly (see Fan/heat sink assembly on page 81)

Remove the processor:

1.

Turn the processor locking screw (1) one-half turn counterclockwise until you hear a click.
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2. Lift the processor (2) straight up and remove it.

EY NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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5

Setup Utility

Computer Setup in Windows 7

To view the drives installed on the computer, select Start > Computer.

On models with a secondary hard drive (drive D), the optical drive becomes drive E. The next drive
added to the system, such as a new USB drive, is be assigned the next available drive letter.

Starting Setup Utility

Setup Utility is a ROM-based information and customization utility that can be used even when the
Windows operating system is not working.

The utility reports information about the computer and provides settings for startup, security, and
other preferences.

To start Setup Utility:

A Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message appears in the lower-left corner of the screen, press the 10 key.

1. Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message appears in the lower-left corner of the screen, press the esc key.

2. When the Startup Menu appears, press the f10 key.

Using Setup Utility

Changing the language of Setup Utility

ENWW

The following procedure explains how to change the language of Setup Utility. If Setup Utility is not
already running, begin at step 1. If Setup Ultility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message appears in the lower-left corner of the screen, press the 10 key.

Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message is appears in the lower-left corner of the screen, press the esc key.
When the Startup Menu displays, press the f10 key.

2. Use the arrow keys to select System Configuration > Language, and then press the enter key.
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Use the arrow keys to select a language, and then press enter key.
When a confirmation prompt with your language selected displays, press the enter key.

To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press the enter key.

Changes goes into effect immediately.

Navigating and selecting in Setup Utility

Because Setup Utility is not Windows based, it does not support the TouchPad. Navigation and
selection are by keystroke.

To choose a menu or a menu item, use the arrow keys.

To choose an item in a list or to toggle a field, for example an Enable/Disable field, use either the
arrow keys or the 5 or 16 keys.

To select an item, press the enter key.
To close a text box or return to the menu display, press the esc key.

To display additional navigation and selection information while Setup Ultility is open, press the
1 key.

Displaying system information

The following procedure explains how to display system information in Setup Utility. If Setup Utility is
not open, begin at step 1. If Setup Ultility is open, begin at step 2.

1.

Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the f10 key.

Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the esc key. When
the Startup Menu displays, press thef10 key.

Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press the enter key.
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Restoring default settings in Setup Utility

The following procedure explains how to restore Setup Utility default settings. If Setup Ultility is not
already running, begin at step 1. If Setup Ultility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the 10 key.

Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the esc key. When
the Startup Menu appears, press the f10 key.

2. Use the arrow keys to select Exit > Load Setup Defaults, and then press the enter key.
3. When the Setup Confirmation appears, press the enter key.

4. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press the enter key.

Setup Utility default settings go into effect when the computer restarts.

Br NOTE: Password, security, and language settings are not changed when you restore the factory
default settings.
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Exiting Setup Utility

You can exit Setup Utility with or without saving changes.

e To exit Setup Utility and save changes from the current session:

If the Setup Utility menus are not displayed, press the esc key to return to the menu display.
Then use the arrow keys to select Exit > Exit Saving Changes, and then press the enter key.

e  To exit Setup Utility without saving changes from the current session:

If the Setup Utility menus are not displayed, press the esc key to return to the menu display.
Then use the arrow keys to select Exit > Exit Discarding Changes, and then press the enter

key.

After either choice, the computer restarts in Windows.

Setup Utility menus

The menu tables in this section provide an overview of Setup Ultility options.

EY NOTE: Some of the Setup Utility menu items listed in this chapter might not be supported by the

computer.

Main menu

Select

To do this

System information

e View and change the system time and date.
e View identification information about the computer.
e View specification information about the processor, memory size,

system BIOS, and keyboard controller version (select models
only).

Security menu

Select

To do this

Administrator password

Enter, change, or delete an administrator password.

Power-On password

Enter, change, or delete a power-on password.
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System Configuration menu

Select

To do this

Language Support

Change the language of Setup Utility.

Button Sound (select models only)

Enable/disable the capacitive button tapping sound.

Virtualization Technology (select models only)

Enable/disable the processor Virtualization Technology.

Processor C6 State (select models only)

Enable/disable the processor C6 sleep state.

LAN Power Saving (select models only)

Enable/disable LAN Power Saving. When enabled, saves power when
the computer is in DC mode.

Card Reader/1394 Power Saving (select models
only)

Enable/disable Card Reader/1394 Power Saving.

Fan Always On

Enabled/disable Fan Always On. When enabled, the computer fan will
always be on.

Action Keys Mode

Enable/disable Action Keys Mode.

Boot Options

Set the following boot options:

e  POST hotkey delay (sec.)—Set the delay for the f1, 2, 9, f10, f11,
and f12 functions of Setup Utility in intervals of 5 seconds each (0,
5,10, 15, 20).

e  CD-ROM Boot—Enable/disable boot from CD-ROM.

e  Floppy Boot—Enable/disable boot from diskette.

° Internal Network Adapter Boot—Enable/disable boot from the
internal network adapter.

o  Boot Order—Set the boot order for:
° Notebook Hard Drive
° Internal CD/DVD ROM Drive
° USB Diskette on Key/USB Hard Disk
o USB CD/DVD ROM Drive
° USB Floppy

° Network Adapter

Diagnostics menu
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Select

To do this

Hard Disk Self Test

Run a comprehensive self-test on the hard drive.

NOTE: On models with two hard drives, this menu option is called the
Primary Hard Disk Self Test.

Secondary Hard Disk Self Test (select models
only)

Run a comprehensive self-test on a secondary hard drive.

Memory Test

Run a diagnostic test on the system memory.
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Computer Setup in Linux

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

Ef NOTE: Some of the Computer Setup menu items listed in this guide might not be supported by the
computer.

NOTE: Pointing devices are not supported in Computer Setup. Use the keyboard to navigate and
make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup:
1. Turn on or restart the computer.

2. Before the operating system opens and when the F10=ROM Based Setup message displays in
the lower-left corner of the screen, press the f10 key.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing the 10 key
when the F10 = ROM Based Setup message appears in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

e To choose a menu or a menu item, use the arrow keys.
e To select an item, press the enter key.

e To close open dialog boxes and return to the main Computer Setup screen, press the esc
key.

e  To view navigation information, press the f1 key.

e To change the language, press the 2 key.
2. Select the File, Security, Diagnostics, or System Configuration menu.
3. To exit Computer Setup, choose one of the following methods:

e  To exit Computer Setup without saving your preferences, use the arrow keys to select File
> Ignore Changes And Exit. Then follow the instructions on the screen.

e To save your preferences and exit Computer Setup, use the arrow keys to select File >
Save Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
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Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory:

1. Open Computer Setup by turning on or restarting the computer, and then pressing the f10 key
when the F10 = ROM Based Setup message displays in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press the enter key.
3. When the confirmation dialog box opens, press the 10 key.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Br NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

Bf NOTE: Some of the Computer Setup menu items listed in this chapter might not be supported by
the computer.

File menu

Select To do this

System information e View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore Changes And Exit Cancel any changes entered during the current session, and
then exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session, and

then exit and restart the computer. Changes go into effect
when the computer restarts.
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Security menu

B NOTE: Some of the menu items listed in this section might not be supported by the computer.

Select

To do this

Setup Password

Enter, change, or delete a setup password.

Power-On Password

Enter, change, or delete a power-on password.

Password Options

e  Enable/disable stringent security.

° Enable/disable the password requirement on computer
restart.

DriveLock Passwords

e  Enable/disable DriveLock on any computer hard drive.

e  Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e  Fast: Runs the Disk Sanitizer erase cycle once.
e  Optimum: Runs the Disk Sanitizer erase cycle 3 times.

e  Custom: Allows you to select the desired number of
Disk Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

Diagnostics menu
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Select

To do this

HDD Self-Test Options

Run a comprehensive self-test on any hard drive in the
system or on any optional MultiBay hard drive.

Memory Check

Run a comprehensive check on system memory.

Computer Setup in Linux
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System Configuration menu

B NOTE: Some of the listed System Configuration options might not be supported by the computer.

Select To do this
Language Change the Computer Setup language.
Boot options e Setanf9, f10, and f12 delay when starting up.

Enable/disable CD-ROM boot.
Enable/disable floppy boot.
Enable/disable internal network adapter boot.

Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

Set the Express Boot Popup delay in seconds.
Set the boot order.

° 1st boot device—USB CD-ROM

° 2nd boot device—USB floppy

° 3rd boot device—USB SuperDisk

° 4th boot device—Notebook hard drive

° 5th boot device—USB hard disk

° 6th boot device—Network controller

Device Configurations °

Swap the functions of the fn key and left ctrl key.

Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when the operating system is not running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

Enable/disable BIOS DMA data transfers.

Enable/disable fan always on while connected to an AC
outlet.

Enable/disable data execution prevention.
Enable/disable LAN power saving mode.
Enable/disable SATA Native Mode.
Enable/disable Dual Core CPU.

Enable/disable HDD translation mode.
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Select

To do this

Built-in device options

Enable/disable embedded WLAN Device Radio.
Enable/disable embedded Bluetooth Device Radio.
Enable/disable Network Interface Controller (NIC)
Enable/disable LAN/WLAN Switching.
Enable/disable Wake on LAN.

Enable/disable the integrated camera (webcam)

Port options

Enable/disable USB port.

Enable/disable ExpressCard slot.

Computer Setup in Linux
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6 Specifications

Computer specifications

Dimensions

Depth 24.7 cm (9.7 in)

Width 37.4cm (14.7 in)

Height (front to rear) 3.2t03.7cm (1.3to0 1.4 in)
Weight (lowest weight configuration) <2.25kg (5.5 Ibs)

Input power

Operating voltage 185Vdc@4.74 A-90W
Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C (32°F to 95°F)
Operating (writing to optical disc) 5°C to 35°C (41°F to 95°F)
Nonoperating -20°C to 60°C (-4°F to 140°F)

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m (-50 ft to 10,000 ft)

Nonoperating -15 m to 12,192 m (-50 ft to 40,000 ft)

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

39.6-cm (15.6-in) display specifications

Dimensions
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Height 21.0 cm (8.27 in)
Width 35.9 cm (14.1in)
Diagonal 39.6 cm (15.6)

Number of colors

Up to 16.8 million

Contrast ratio

300:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch 0.259 x 0.259 mm

Format 1280 x 800; HD: 1366 x 768
Configuration RGB vertical stripe
Backlight LED

Character display 80 x 25

Total power consumption 40W

Viewing angle

+40° horizontal, +120/-40° vertical (typical)
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Hard drive specifications

750 GB* 640 GB* 500 GB* 320 GB* 250 GB* 160 GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm 70 mm 70 mm
Weight 101g 101g 101g 1019 101g 101g
Interface type SATA SATA SATA SATA SATA SATA
Transfer rate 100 MB/sec 106 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA ATA ATA ATA ATA ATA

security security security security security security

Seek times (typical read, including setting)

Single track 3.0ms 1.0 ms 1.0 ms 1.5ms 20ms 1.5ms

Average 13.0 ms 14.0 ms 14.0 ms 12.0 ms 12.0 ms 11.0 ms

Maximum 24.0 ms 24.0 ms 22.0ms 22.0 ms 22.0ms 22.0ms

Logical blocks 1,465,128.3 1,250,263,7 976,773,16 625,142,44 488,397,16 312,581,80
59 28 8 8 8 8

Disc rotational speed 5400 rpm 5400 rpm 7200 rpm 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD*RW and CD-RW SuperMulti Double-Layer Combo
Drive with LightScribe specifications

Applicable disc

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, MIXED
MODE CD, CD-I, CD-I Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD
+RW, DVD-RAM

Write CD-R and CD-RW, DVD+R, DVD+RW, DVD-R, DVD-RW, DVD-RAM

Random access time

DVD <230 ms
CD <175 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec

Transfer mode

Multiword DMA Mode

104 Chapter 6 Specifications

ENWW



Blu-ray ROM with LightScribe DVDR/RW SuperMulti
Double-Layer Drive specifications

ENWW

Applicable disc

Read

BD-ROM, BD-ROM-DL, BD-R, BD-R-DL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVD-R, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and mode 2), CD-ROM XA (mode 2,
form 1 and form 2), Photo CD (single and multiple sessions), CD Extra,
CD-R, CD-RW, and CD-TEXT

Write

DVD-RAM (Ver.2), DVD+R, DVD-R, CD-R, and CD-ROM

Random access time

BD <230 ms
DVD <180 ms
CD <180 ms
Cache buffer 4.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
4X BD 18,000 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec
1X BD-ROM 4,500 KB/sec
1X BD-R read 4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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System resource specifications

Use Device Manager to get a graphical view of the system resources that control how the devices
work on the computer. System resources accessible from Device Manager are direct memory access
(DMA) channels, input/output (1/O) ports, interrupt request (IRQ) lines, and memory addresses.

If two devices require the same resource and create a device conflict, manually change the resource
settings in Device Manager to be sure each setting is unique.

/A CAUTION: Improperly changing resource settings can disable the hardware and cause the
computer to malfunction or become inoperable. Only users who have expert knowledge of computer
hardware and hardware configurations should change resource settings.

To view resource settings in Windows 7 and Windows Vista:
1.  Select Start > Computer.
2. Click System properties near the top of the Computer folder.
3. Onthe left, click Device Manager.
4. On the View menu, click one of the following:
e Resources by type
e Resources by connection
To view resource settings in Windows XP:
1. Select Start > My Computer, or double-click My Computer on the desktop.
2. Under System Tasks, click View system information.
3. In the System Properties window, select the Hardware tab.
4. Click Device Manager.
5. On the View menu, click one of the following:
e Resources by type

e Resources by connection
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Backup and recovery

Recovery after a system failure is as complete as your most current backup. HP recommends
creating recovery discs immediately after software setup. As you add new software and data files,
continue to back up your system on a regular basis to maintain a reasonably current backup.

Tools provided by the operating system and HP Recovery Manager software are designed to help
you with the following tasks for safeguarding your information and restoring it in case of a system
failure:

e Creating a set of recovery discs (Recovery Manager software feature). Recovery discs are used
to start up (boot) the computer and restore the operating system and software programs to
factory settings in case of system failure or instability.

e  Backing up your information regularly to protect your important system files.

e Creating system restore points (operating system feature). System restore points allow you to
reverse undesirable changes to your computer by restoring the computer to an earlier state.

e Recovering a program or driver (Recovery Manager software feature). This feature helps you
reinstall a program or driver without performing a full system recovery.

e Performing a full system recovery (Recovery Manager software feature). With Recovery
Manager, you can recover the full factory image if you experience system failure or instability.
Recovery Manager works from a dedicated recovery partition (select models only) on the hard
drive or from recovery discs you create.

B NOTE: Computers with a solid-state drive (SSD) might not have a recovery partition. Recovery
discs have been included for computers that do not have a partition. Use these discs to recover
the operating system and software. To check for the presence of a recovery partition, select
Start >right-click Computer > click Manage > click Disk Management. If the partition is
present, an HP Recovery drive is listed in the window.

Windows 7

To protect your information, back up your files and folders. In case of system failure, use the backup
files to restore the computer.

/A CAUTION: In the event of a hard drive failure, you cannot use the computer to access the Disaster

ENWW

Recovery utility. Therefore, HP recommends downloading the Disaster Recovery utility SoftPaq, and
then extract it to a USB flash drive as soon as possible after software setup. For details, see
“Downloading and extracting the Disaster Recovery utility” later in this section.
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Depending on the computer model, you might have one of the following backup and recovery
solutions:

° Roxio BackOnTrack

e HP Recovery Manager

B NOTE: For detailed information, perform a search for these topics in Help and Support.

Creating recovery discs

HP recommends creating recovery discs to be sure that you can restore your system to its original
factory state if you experience serious system failure or instability. Create these discs after setting up
the computer for the first time.

Handle these discs carefully and keep them in a safe place. The software allows the creation of only
one set of recovery discs.

NOTE: Use an optional external optical drive (purchased separately) to create recovery discs, or
purchase recovery discs for the computer from the HP Web site.

Note the following guidelines before creating recovery discs:

B NOTE: The external hard drive must be connected to a USB port on the computer, not to a USB
port on an external device such as a hub.

e  Use high-quality DVD-R, DVD+R, BD-R (writable Blu-ray), or CD-R discs. All these discs are
purchased separately. DVDs and BDs have a much higher capacity than CDs. If you use CDs,
up to 20 discs might be required, whereas only a few DVDs or BDs are required.

B¥ NOTE: Read-write discs, such as CD-RW, DVD+RW, double-layer DVD+RW, and BD-RE
(rewritable Blu-ray) discs, are not compatible with the Recovery Manager software.

e The computer must be connected to AC power during this process.
e  Only one set of recovery discs can be created per computer.
e Number each disc before inserting it into the optical drive.

e If necessary, exit the program before you have finished creating the recovery discs. The next
time you open Recovery Manager, you are prompted to continue the disc creation process.

To create a set of recovery discs:
1. Select Start > All Programs > Recovery Manager > Recovery Disk Creation.

2. Follow the on-screen instructions.
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Backing up your information

As you add new software and data files, back up the system on a regular basis to maintain a
reasonably current backup. Back up your system at the following times:

e Atregularly scheduled times

Ef NOTE: Setreminders to back up your information periodically.

e Before the computer is repaired or restored
e  Before you add or modify hardware or software
Note the following when backing up:

e Create system restore points using the Windows System Restore feature, and periodically copy
them to disc.

e  Store personal files in the Documents library and back up this folder periodically.
e  Back up templates stored in their associated programs.

e  Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document steps:
1. Display the screen.
2. Copy the screen:
To copy only the active window, press alt+prt sc.
To copy the entire screen, press prt sc.
3. Open a word-processing document, and then select Edit > Paste.
4. Save the document.
e  Back up the information to an optional external hard drive, a network drive, or discs.

e  When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD-R, or DVD+RW. The discs you use will depend on the type of optical
drive installed in the computer.

B NOTE: DVDs store more information than CDs, so using them for backup reduces the number
of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.
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Using Windows Backup and Restore

To create a backup using Windows Backup and Restore:

B NOTE: Be sure that the computer is connected to AC power before starting the backup process.

NOTE: The backup process might take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up and create a backup.

B NOTE: Windows includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Using system restore points

When backing up the system, you are creating a system restore point. A system restore point allows
you to save and name a snapshot of your hard drive at a specific point in time. You can then recover
back to that point if you want to reverse subsequent changes made to the system.

Br NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created
since the last restore point.

You also can create additional restore points to provide increased protection for the system files and
settings.

When to create restore points

Before you add or extensively modify software or hardware

Periodically, whenever the system is performing optimally

Br NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.

Create a system restore point

1.

2
3
4.
5
6

Select Start > Control Panel > System and Security > System.

In the left pane, click System Protection.

Click the System Protection tab.

Under Protection Settings, select the disk for which you want to create a restore point.
Click Create.

Follow the on-screen instructions.

Restore to a previous date and time

To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:

1.
2
3.
4

5.

Select Start > Control Panel > System and Security > System.
In the left pane, click System protection.

Click the System Protection tab.

Click System Restore.

Follow the on-screen instructions.

Performing a recovery

Br NOTE: You can recover only files that you have previously backed up. HP recommends using
Recovery Manager to create an entire drive backup as soon as you set up the computer.
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Recovery Manager software allows you to repair or restore the system if you experience system
failure or instability. Recovery Manager works from recovery discs or from a dedicated recovery
partition (select models only) on the hard drive. However, if the computer includes a solid-state drive
(SSD), you might not have a recovery partition. If that is the case, recovery discs are included with
the computer. Use these discs to recover the operating system and software.
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B NOTE: Windows has its own built-in repair features, such as System Restore and driver roll-back
capabilities. Try these features before using Recovery Manager.

NOTE: Recovery Manager recovers only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Website or reinstalled from
the disc provided by the manufacturer.

Recovering from the recovery discs
To restore the system from the recovery discs:
1. Back up all personal files.
2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Recovering from the dedicated recovery partition (select models only)

B NOTE: If the computer includes an SSD, you might not have a recovery partition. You cannot
recover using this procedure. Recovery discs are included for computers that do not have a partition.
Use these discs to recover the operating system and software.

On some models, you can perform a recovery from the partition on the hard drive, accessed by
pressing either the Start button or f11. This restores the computer to its factory condition.

To restore the system from the partition, follow these steps:
1. Access Recovery Manager in either of the following ways:
e  Select Start > All Programs > Recovery Manager > Recovery Manager.
—or—

e Turn on or restart the computer, and then press esc while the “Press the ESC key for
Startup Menu” message is displayed at the bottom of the screen. Then, press 11 while the
“Press <F11> for recovery” message appears

2. Click System Recovery in the Recovery Manager window.

3. Follow the on-screen instructions.
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Linux backup and recovery

Use the instructions in this section if SUSE Linux SLED 11 is installed on the computer.

To protect your information, back up your files and folders. Then if the system fails, restore your
important files from copies. Use the options listed in this section to restore the operating system and
programs that were installed at the factory.

/A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
created and any software installed on the computer are permanently removed. The 11 recovery tool
reinstalls the original operating system and HP programs and drivers that were installed at the
factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal
files must be restored from a backup.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. Restart the computer, and then press f11 while the “Press <F11> for recovery” message
appears on the screen.

3. Follow the on-screen instructions.

Br NOTE: If you are unable to boot (start up) the computer from the primary operating system or from
the recovery f11 method, purchase a SUSE Linux Enterprise Desktop Operating System DVD to
repair the operating system. For additional information, see the Worldwide Telephone Numbers
booklet, included with the computer.
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8 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel
2 Audio out, right channel
3 Ground

ENWW

Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground
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External monitor

@O 006
®000
®00006

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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RJ-11 (modem)

111
123456

Pin Signal

Unused

Tip

Ring

Unused

Unused

o | 0| M| W | N| =

Unused

RJ-45 (network)

i
12345678

] —

py
5

Signal

Transmit +

Transmit -

Receive +

Unused

Unused

Receive -

Unused

o0 | N o | o B~ WO|DN| =

Unused
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HDMI

1917151311 9 7 5 3 1

NrATATATAVATATATATASS

1816 141210 8 & 4 &

Pin Signal

1 TMDS data 2+

2 TMDS data 2 shield
3 TMDS data 2—

4 TMDS data 1+

5 TMDS data 1shield
6 TMDS data 1-

7 TMDS data 0+

8 TMDS data 0 shield
9 TMDS data 0—

10 TMDS clock+

11 TMDS clock shield
12 TMDS clock—

13 CEC

14 No connect

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect

20 Shell

118 Chapter 8 Connector pin assignments

ENWW



Universal Serial Bus

ENWW

1 2 3 4
I_-_-_-.I

Pin Signal
1 +5VDC
2 Data -
3 Data +
4 Ground
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9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries or regions

The requirements listed below are applicable to all countries or regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by each country or region’s power system.

e  The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries or regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

/A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

B NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury might be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

Q-

Br NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

-
1
T

Hid g
i

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel (3).
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4. Remove the two screws (1) that secure each hinge to the display enclosure and lift up to remove
the display hinge covers (2).

o

T

e,

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

— ——— — ———— —
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7. Turn the display panel assembly upside down and remove all screws that secure the display
panel frame to the display panel.

8. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.

9. Remove the display panel frame (2) from the display panel.

10. Remove the screws (1) that secure the backlight cover to the display panel.

11. Lift the top edge of the backlight cover (2) and swing it outward.

—0

u
o\

12. Remove the backlight cover.

13. Turn the display panel right-side up.
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14. Remove the backlight cables (1) from the clip (2) in the display panel.

15. Turn the display panel upside down.

16. Remove the backlight frame from the display panel.

A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
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17. Remove the backlight from the backlight frame.

18. Disconnect the display cable (1) from the LCD panel.

19. Remove the screws (2) that secure the LCD panel to the display rear panel.
20. Release the LCD panel (3) from the display rear panel.

21. Release the tape (4) that secures the LCD panel to the display rear panel.
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22. Remove the LCD panel.

23. Recycle the LCD panel and backlight.
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Index

Symbols/Numerics
1394 Power Saving 93

A
AC adapter
identifying 17
AC adapter, spare part numbers
32
administrator password 92
antenna
removal 75
antennas 15
applications key, Windows 11
audio, product description 3
audio-in jack, pin assignments
115
audio-out jack, pin assignments
115

B
backing up
customized window, toolbar,
and menu bar settings 109
personal files 109
templates 109
base enclosure, spare part
number 25
battery
removal 46
spare part numbers 25, 46
battery bay, identifying 15
battery release latch, identifying
15
battery, identifying 17
bays
battery 15
hard drive 15
BD/DVD+R/RW Super Multi
Double-Layer Combo Drive
removal 50

ENWW

bezel
illustrated 27
spare part number 27,73
Blu-ray Disc ROM LightScribe with
SuperMulti DVD+R/RW Double-
Layer
spare part number 30, 50
Blu-ray ROM with LightScribe DVD
+R/RW SuperMulti DL Drive
specifications 105
boot options 93, 98
boot order 93, 98
button sound 93
buttons
power 10
TouchPad right/left 8

C
cables, service considerations 40
camera module

removal 73

spare part number 73
camera, product description 3
caps lock light, identifying 9
Card Reader Power Saving 93
changing the language of Setup
Utility 89
chipset, product description 2
compartments

memory module 15
components

additional hardware 17
bottom 15

front 7

left-side 14

right-side 13

top 8
computer feet

locations 45

spare part number 45

Computer Setup
accessing 94
Diagnostics menu 97
File menu 96
navigating and selecting 94
restoring factory settings 95
Security menu 97
System Configuration menu
98
using 94
computer specifications 101
connector pin assignments
audio-in 115
audio-out 115
external monitor 116
HDMI 118
headphone 115
microphone 115
modem 117
monitor 116
network 117
RJ-11 117
RJ-45 117
Universal Serial Bus (USB)
119
connector, power 13
connectors, service
considerations 40
cord, power 17

D
Diagnostics menu 93, 97
Digital Media Slot light,
identifying 14

Digital Media Slot, identifying 14
diskette drive

precautions 40
display assembly

removal 70

spare part number 21, 70
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display back cover
spare part number 28
display bezel
illustrated 27
spare part number 27,73
display bracket and hinge
removal 74
spare part number 75
display cable kit
spare part number 28
display component recycling 123
display components
illustrated 27
spare part numbers 27
display enclosure
illustrated 27
display hinge kit, spare part
number 28
display inverter
illustrated 27
display panel
illustrated 27
product description 2
removal 74
spare part number 28, 74
Display screw kit, spare part
number 28
display specifications 101
displaying system information 90
drives
boot order 93, 98
preventing damage 40
DVD/CD-RW Combo Drive
precautions 40
removal 50
DVD+RW and CD-RW Combo
Drive
precautions 40
removal 50
DVD+RW SuperMulti DL Drive
with LightScribe
spare part numbers 30, 50
DVD+RW SuperMulti Double-
Layer Drive with LightScribe
specifications 104

E

electrostatic discharge 41

esc key, identifying 11
Ethernet, product description 3

132 Index

exiting Setup Utility 92
external media cards, product
description 4
external monitor port
pin assignments 116
external monitor port, identifying
14

F

f11 112

fan always on 93
fan/heat sink assembly

removal 81
spare part number 21, 81
feet

locations 45

spare part number 45
File menu 96
fn key, identifying 11
front components 7
full system recovery 107
function keys, identifying 11

G

graphics, product description 2

grounding equipment and
methods 43

H
hard drive
precautions 40
product description 3
removal 47
spare part numbers 22, 30, 47
specifications 103
hard drive bay, identifying 15
hard drive cover
illustrated 29
removal 48
hard drive hardware kit, spare part
number 31
hard drive self test 93
HDMI 14
HDMI port, pin assignments 118
headphone jack, pin
assignments 115

|
inverter
illustrated 27

J

jacks
RJ-11 (modem) 13
RJ-45 (network 14

K

keyboard
product description 5
removal 57
spare part numbers 21, 57

keys
Calculator 11
esc 11
fn 11
function 11
Media application 11
Print 11

Send e-mail 11

Web browser 11
Windows applications 11
Windows logo 11

L
LAN Power Saving 93
language support 93
latch, battery release 15
legacy support, USB 94, 98
light

power 9
lights

caps lock 9

Digital Media Slot 14

webcam 12

wireless 9

M
Main menu 92
mass storage devices, spare part
numbers 30
memory module
product description 2
removal 55
spare part numbers 22, 55
memory module compartment,
identifying 15
memory test 93
microphone (internal), identifying
12
microphone jack, pin
assignments 115
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microphone, product description
3
mini-card compartment cover
illustrated 29
removal 55
spare part number 55
model name 1
modem jack, pin assignments
117
modem module
product description 3
removal 65
spare part number
modem module cable
removal 78
monitor port, external 14
monitor port, pin assignments
116

22,65

N

navigating in Setup Utility 90

network jack, pin assignments
117

(0]
operating system, product
description 5
optical drive
identifying 13
precautions 40
product description 3
removal 50
spare part numbers 25, 30, 50
specifications 104, 105

P
packing guidelines 42
passwords 92, 97
performing a recovery 111
plastic parts 39
Plastics kit
contents 29
spare part number 29
pointing device, product
description 5
ports
external monitor 14
HDMI 14
product description 4
USB 13, 14
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power button board

removal 63

spare part number 63
power button, identifying 10
power connector cable

removal 69

spare part number 25, 69
power connector, identifying 13
power cord set requirements 121
power cord, identifying 17
power cord, spare part numbers

32
power light, identifying 9
power requirements, product
description 5

power-on password 92
processor

product description 1

removal 85

spare part numbers 23, 85
Processor C6 State 93
product description

audio 3

camera 3

chipset 2

display panel 2

Ethernet 3

external media cards 4

graphics 2

hard drives 3

keyboard 5

memory module 2

microphone 3

modem module 3

operating system 5

optical drives 3

pointing devices 5

ports 4

power requirements 5

processors 1

product name 1

security 5

serviceability 5

wireless 4
product name 1

R
recovering a program or driver
107

recovering from the dedicated
recovery partition 112
recovering from the recovery
discs 112
recovery discs 107, 108
Recovery Manager 107, 111
recovery partition 107
recovery, system 111
removal/replacement
preliminaries 39
procedures 44
restore points 111
restoring default settings 91
RJ-11 (modem) jack, identifying
13
RJ-11 jack, pin assignments 117
RJ-45 (network) jack, identifying
14
RJ-45 jack, pin assignments 117
RTC battery
removal 79
spare part number 22,79
Rubber Feet Kit, spare part
number 45

S
secondary hard drive self test 93
security cable slot, identifying 13
Security menu 92, 97
security, product description 5
selecting in Setup Utility 90
serial number 19, 44
service considerations 39
serviceability, product
description 5
setup utility
Diagnostics menu 97
File menu 96
navigating and selecting 94
restoring factory settings 95
Security menu 97
System Configuration menu
98
slots
Digital Media 14
memory module 15
security cable 13
solid-state drive (SSD)
112

107, 111,
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speaker assembly
removal 62
spare part number 21, 62
speakers, identifying 10
specifications
Blu-ray ROM with LightScribe
DVDzR/RW SuperMulti DL
Drive 105
computer 101
display 101
DVD *RW SuperMulti Double-
Layer Drive with LightScribe
104
hard drive 103
optical drive 104, 105
system resources 106
starting Setup Utility 89
static-shielding materials 43
stringent security 97
supported discs 108
system board
removal 76
spare part numbers 22, 76
System Configuration menu 93,
98
system failure or instability 107
system fan 98
system information 92, 96
system recovery 111
system resources 106
system restore points 107, 111

-
thermal paste, replacement 83,
84

tools required 39
top cover

removal 59

spare part number 21, 59
TouchPad

buttons 8

identifying 8

removal 64
TouchPad button board

spare part number 64
TouchPad zone

identifying 8
transporting guidelines 42
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U
Universal Serial Bus (USB) port,
pin assignments 119

USB board

removal 67

spare part number 25, 67
USB legacy support 94, 98
USB ports, identifying 13, 14
using Setup Utility 89
using system restore 111

\'
vents, identifying 14, 15
Virtualization Technology 93

w
webcam
identifying 12
webcam light, identifying 12
Webcam module
spare part number 28
Windows applications key,
identifying 11
Windows logo key, identifying
wireless antenna
removal 75
wireless antennas 15
wireless antennas and cables
removal 75
spare part number 75
wireless antennas and cables,
spare part number 75
wireless light 9
wireless, product description 4
wireless/memory module
compartment cover
removal 53
spare part number 53
WLAN module
removal 52
spare part numbers 24, 52
workstation guidelines 42
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